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Resumen del proyecto: 

Este proyecto tiene como finalidad conocer la historia del automóvil Willys MB / Ford 
GPW (Jeep), realizar su modelización y el estudio de su comportamiento dinámico.  

En primer lugar, analizaremos la historia del vehículo y como ha ido evolucionando con 
el transcurso de los años. 

Seguidamente, se describirán los diferentes subsistemas que conforman el vehículo 
como son el chasis, el motor, las suspensiones de ballesta delanteras y traseras, la 
dirección, el palier, las ruedas y los frenos. 

Una vez descritos los diferentes subsistemas, se procederá a implementarlos en el 
programa informático Adams Car, con el cual analizaremos el comportamiento de las 
suspensiones y del vehículo en su totalidad. 

Finalmente, tras obtener los resultados los contrastaremos con la realidad y 
realizaremos un presupuesto del proyecto. 
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Resum del projecte: 

Aquest projecte té com a finalitat conéixer la història de l'automòbil Willys MB / Ford 
GPW (Jeep), realitzar la seua modelització i l'estudi del seu comportament dinàmic.  

En primer lloc, analitzarem la història del vehicle i com ha anat evolucionant amb el 
transcurs dels anys. 

Seguidament, es descriuran els diferents subsistemes que conformen el vehicle com són 
el xassís, el motor, les suspensions de ballesta davanteres i posteriors, la direcció, la 
tracció, les rodes i els frens. 

Una vegada descrits els diferents subsistemes, es procedirà a implementar-los en el 
programa informàtic Adams Car, amb el qual analitzarem el comportament de les 
suspensions i del vehicle íntegrament. 

Finalment, després d'obtindre els resultats els contrastarem amb la realitat i 
realitzarem un pressupost del projecte. 
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Project summary: 

The intent of this project is to learn about the history of the Willys MB / Ford GPW 
(Jeep) automobile, perform its modeling and study its dynamic behavior. 

First, we will analyze the history of the vehicle and how it has evolved over the years. 

Next, the different subsystems that make up the vehicle will be described, such as the 
chassis, the engine, the front and rear leaf spring suspensions, the steering, the drive 
shaft, the wheels and the brakes. 

Once the different subsystems have been described, we will proceed to implement them 
in the Adams Car computer program, with which we will analyze the behavior of the 
suspensions and the vehicle as a whole. 

Finally, after obtaining the results, we will contrast them with reality and make a budget 
for the project. 
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1. Introducción 
1.1. Introducción al proyecto 

 

En el trascurso de los años, desde que se inventó el automóvil, hemos podido observar 

cómo ha evolucionado el ámbito automovilístico. Hemos visto cómo los materiales, la 

potencia, eficiencia, maniobrabilidad y seguridad de los automóviles se han ido 

desarrollando y optimizando. Como también los ensayos y pruebas analíticas a los 

cuales se sometían los diferentes subsistemas que componen un vehículo.  

En un principio, para poder desarrollar y optimizar estos subsistemas había que 

realizar ensayos puramente prácticos y empíricos. Es decir que, para poder obtener 

resultados y análisis para el desarrollo de cierto componente, había que someterlo a 

ensayos físicos. Método que como podemos imaginar tiene una variedad de 

desventajas. Desde el aspecto económico, de incertidumbre y hasta el alto riesgo. Ya 

que lo que implica un ensayo físico-destructivo, es una gran cantidad de material que 

habrá que reponerse tras cada ensayo, sumándole la variedad de pruebas necesarias 

para poder revelar la razón del mal funcionamiento y por sobre todo lo anterior, el 

riesgo vital al cual debe exhibir el conductor.   

Con el tiempo, a medida que la tecnología evolucionaba y contribuía en campos tan 

variados como el confort, la mercadotecnia, la sanidad y la seguridad; también 

revoluciono el campo automovilístico. Tras la creación de programas de cálculo con 

cada vez mayor precisión de análisis, sensores, estudios y protocolos de seguridad; es 

que los ensayos de producción y calidad de los automóviles se han superado hasta lo 

que es hoy en día.  De manera que en la actualidad podemos diseñar, ensamblar, 

ensayar y re configurar u optimizar un vehículo, todo tras la pantalla de un ordenador 

con una precisión y asertividad abrumadoras. Con un coste significativamente menor, 

menor necesidad de recursos tanto materiales como de mano de obra y lo más 

importante mayor seguridad y un riesgo humano casi nulo.  

Con los programas informáticos que se utilizan en la actualidad, podemos incluso 

analizar comportamientos aislados, identificar problemas individualizados, probar 

variedad de diseños, someter a una interminable cantidad de pruebas y condiciones sin 

que eso suponga un aumento insostenible de recursos económicos. Y seguir analizando 

y verificando el modelo hasta conseguir un comportamiento que satisfaga las 

necesidades del fabricante. 

De esta manera, utilizando una herramienta informática llamada Adams Car, haremos 

uso de la tecnología que se tiene al momento para modelar y analizar la simulación 

dinámica del automóvil Willys MB / Ford GPW (Jeep). 
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1.2. Objetivos del proyecto 
 

El propósito principal de este proyecto es estudiar el modelado y la simulación 

dinámica de un automóvil. En específico elegimos el Willys MB / Ford GPW, por su 

trascendencia histórica y, por sobre todo debido a la novedad que representa estudiar 

un vehículo de tracción integral y de suspensiones de ballesta. Estudiar el 

comportamiento dinámico de un vehículo vendría siendo una de los estudios de mayor 

relevancia en el campo de la ingeniería mecánica. Y estudiar el vehículo que da pie a lo 

que vendrían siendo hoy en día los vehículos de todoterreno de uso civil, es sumamente 

enriquecedor para profundizar en el estudio y comprensión de la mecánica automotriz.  

Por lo tanto, el objetivo de este proyecta será modelizar un ejemplar lo más aproximado 

a la realidad que podamos del Willys MB/Ford GPW, con la ayuda del programo 

informático Adams Car, para poder analizar su comportamiento dinámico. 

Para ello primero habremos de seguir un procedimiento que nos permita abordar de 

manera óptima el análisis que queremos realizar. Así pues, existen ciertos objetivos que 

engloban el proyecto los cuales desarrollaremos de la siguiente manera: 

 Recoger información de la historia del vehículo y documentación técnica acerca 

de sus características geométricas y mecánicas para el modelado y ajuste de 

propiedades de sus componentes en Adams Car. 

 Modelado de la carrocería, el motor, las suspensiones, la dirección, el palier, las 

ruedas y por último de los frenos.  

 Ensamblado del vehículo completo y de las suspensiones, para su posterior 

estudio. Lo cual nos dará las herramientas necesarias para ajustar y aproximar 

el vehículo al comportamiento real de este. 

 Simulación dinámica y análisis comparativo del comportamiento del vehículo 

modelado con la realidad del mismo. 

Además, pretendemos que en el trascurso de cumplimentar cada uno de estos puntos 

profundicemos y adquiramos los siguientes conocimientos:  

 Utilización de programas de diseño en 3D como es SolidWorks y programas de 

análisis de comportamiento mecánico como es Adams Car. 

 Relevancia histórica de los automóviles y en específico del vehículo Willys 

MB/Ford GPW. 

 Familiarizarse con las propiedades mecánicas y con las complicaciones y 

singularidades de un automóvil, poniendo en práctica así los conocimientos 

obtenidos del grado de en ingeniería mecánica  
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2. Historia del vehículo 
 

La historia del Jeep Willys MB/Ford GPW es una de las más importantes en la historia 

del automóvil. Vehículo que ha logrado convertirse en un mito de la eficacia “off-road”, 

un automóvil capaz de superar cualquier terreno.  

El Willys MB, es un vehículo todoterreno de tracción en las cuatro ruedas, que fue 

desarrollado y fabricado por la empresa estadounidense Willys-Overland Motors. Su 

diseño no estaba basado en ninguna otra clase de vehículo, siendo concebido como 

respuesta a un llamamiento realizado en 1940 por el alto mando militar 

estadounidense.  

El ejército estadounidense había decidido equiparse con un vehículo de reconocimiento 

ligero. Utilizando la American Bantam Car Company ubicada en Pennsylvania (EE. UU.). 

Que fabricó en apenas 49 días el primer prototipo del Willys para el ejército americano, 

cumpliendo la demanda de un vehículo ligero de transporte eficaz y ágil para el traslado 

de los soldados por el frente de batalla, sobre cualquier tipo de terreno.  

 

  

Figura 1: [ 2-1] Prototipo todoterreno desarrollado por Bantman, precursor del actual Jeep. (Ref. 1) 

 

Seguidamente el Ejercitó animó a Ford Motor Company y Willys-Overland Motors a 

presentar sus propios prototipos sobre la base del de Bantam. El prototipo de Bantam 

era el de menos coste, mientras que el de Willys era el más potente, y el de Ford el que 

mayor comodidad de conducción presentaba (palanca de cambios, asientos etc.). En un 

polémico concurso con intereses comerciales de por medio, finalmente se encargó a 

estas dos últimas la producción del vehículo, aunando lo mejor de cada prototipo, 
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aduciendo su mayor capacidad de producción. Lamentablemente para la American 

Bantam Company serían sus últimos vehículos porque tuvo que cerrar en diciembre de 

1941. 

 

 

Figura 2: [2-2] Primeros prototipos de la competencia desde arriba El Willys Quad, el Ford Pygmy y el Bantam BRC 60 
(Ref. 2) 
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Figura 3: [2-3] Evolución de los prototipos, de izquierda a derecha: El Bantam BRC 40, el Ford GP y el Willys MA (Ref. 2) 

 

 

Figura 4: [2-4] Prototipos de la competencia juntos (Ref. 3) 

 

El modelo adoptado en octubre de 1941 por el ejército de los Estados Unidos es el 

producido por Willys que paso a llamarse MB, unificando la producción de unos 1600 

vehículos de este fabricante. Este hibrido es el que ya ahora todos reconocemos como 

un Jeep. Pero una vez que Estados Unidos fue a la guerra después del episodio de Pearl 

Harbor en diciembre de 1941, el Ejército quiere que se le suministren vehículos de 

reconocimiento de al menos dos proveedores diferentes: elige a Ford, que produce el 

mismo vehículo fabricado por Willys pero esta vez la nombró GPW. 

Muy rápidamente, este pequeño vehículo de reconocimiento es apodado “Jeep”. Y es 

aquí de donde proviene el origen de este apodo, de la contracción oral de las letras GP 

(para “General Purpose”: Multiple Role) que se convierte en “Jeep”. 
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Figura 5: [2-5] Modelo hibrido adoptado (Ref. 4) 

 

 

Figura 6: [2-6] El Willys MB que  heredaba las entradas del Bantam y el capó del Ford (Ref. 5) 

 

Gracias a su agilidad, versatilidad, tracción en terreno embarrado, pantanoso, o helado, 

robustez y resistencia a las peores condiciones climatológicas, tuvo múltiples 

utilidades. Sirvió como ambulancia, como coche de mando y exploración con una 

ametralladora Browning en su caja trasera, como soporte de lanzacohetes y morteros, 

como camión de bomberos en portaaviones, como remolcador de piezas de artillería, 

vehículo de control aéreo en aeródromos, vehículo base para tropas paracaidistas, 

portando cable telefónico, con seis ruedas para patrullaje de la Guardia Costera etc.  
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Figura 7: [2-7] Variaciones que se le hicieron al Jeep durante la guerra. (Ref. 6) 

 

Además, en el teatro de operaciones de Birmania fue adaptado como locomotora, y de 

acuerdo con la ley de préstamo y arriendo fue suministrado en grandes cantidades a 

Gran Bretaña (debutando en la campaña del Norte de África con excelentes resultados) 

y posteriormente en Francia como vehículo de asalto para atacar bases y convoyes 

armándolo con ametralladoras antiaéreas. Y además en 1942 se produjo una versión 

anfibia de la Unión Soviética, contribuyendo sobremanera a la motorización del Ejército 
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rojo, donde también la GAZ hizo su propia versión. Si bien, de menos éxito que su 

hermano mayor, fue bastante útil para los soviéticos. 

 

 

Figura 8: [2-8] Variación soviética del Willys MB (Ref. 7) 

 

 

Figura 9: [2-9] El GAZ soviético en una recreación histórica (Ref. 7) 

 

Habiendo que mencionar también que las prestaciones del Willys MB eran superiores 

a su homólogo alemán el Kübelwagen Tipo 82 (basado en el Volkswagen Tipo 1 

(Escarabajo)). 

 

Después de la II Guerra Mundial el MB fue sustituido por el Willys M38. En Francia, 

Hotchkiss construyó bajo licencia Willys el modelo Hotchkiss M201, que muchas 

personas confunden equivocadamente con el MB o el GPW. 

Utilizado por una gran mayoría de ejércitos en todo el mundo después de la Segunda 

Guerra Mundial, el Jeep es uno de los símbolos de este conflicto internacional. 
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Figura 10: [2-10] Willys MC/M38 (Ref. 8) 

 

 

Figura 11: [2-11] Willys M38 izquierda vs MB derecha (Ref. 8) 

 

Pero el Jeep, no sólo es reconocido como la mayor contribución de EE.UU. a la guerra 

(General Marshall dixit), sino que abrió la puerta a una nueva generación de vehículos 

todo terreno con múltiples usos comerciales y civiles tras la II Guerra Mundial, como 

son toda la serie de Willys CJ (Civilian Jeep) ya fabricados para uso civil a diferencia del 

MB o el GPW que se fabricaron únicamente para su uso en la guerra.  
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Figura 12: [2-12] Variaciones del Willys MB todoterreno para uso comercial y civil (Ref. 9) 

 

 

Figura 13: [2-13] 1963 Jeep CJ5 Willys (Ref. 10) 

 

El Jeep CJ5 fue el modelo que consagró el concepto original y que lo mantuvo en el 

mercado durante varias décadas. Nacido en el año 54, desembocó en su sucesor, el 

actual Jeep Wrangler, en 1987: no obstante, el tiempo pasó, pero sus formas apenas 

sufrieron cambios de consideración, más allá de mejoras mecánicas, de equipamiento o 

del sistema de tracción. Este Jeep lleva ya 30 años con nosotros y su evolución ha 

seguido siendo ligera, manteniendo su espíritu sin cambios: ese ha sido su principal 

valor. 
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3. Herramientas empleadas 
3.1. SolidWorks 2019 

 

SolidWorks es un software CAD (diseño asistido por computadora) para modelado 

mecánico en 2D y 3D, desarrollado en la actualidad por SolidWorks Corp., una filial de 

Dassault Systèmes, S.A. (Suresnes, Francia), para el sistema operativo Microsoft 

Windows. Su primera versión fue lanzada al mercado en 1995 con el propósito de hacer 

la tecnología CAD más accesible. 

El programa informático, uno de los más útiles el campo del diseño ingenieril, nos 

permite modelar piezas y conjuntos además de extraer de ellos tanto planos técnicos 

como otro tipo de información necesaria para la producción. Es un programa que 

funciona con base en las nuevas técnicas de modelado con sistemas CAD. El proceso 

consiste en traspasar la idea mental del diseñador al sistema CAD, "construyendo 

virtualmente" la pieza o conjunto. Posteriormente todas las extracciones (planos y 

ficheros de intercambio) se realizan de manera bastante automatizada.  

En el caso de este proyecto de fin de grado, utilizamos esta herramienta para poder 

visualizar el modelo en 3D del vehículo, para crear archivos independientes que solo 

estén conformados del chasis y otro de las ruedas y posteriormente para importar los 

archivos de modelado del Willys MB/Ford GPW convirtiéndolos a un formato 

compatible con el programa MSC Adams Car (Parasolid). 

 

 

3.2. MSC Adams Car 2019 
 

MSC Adams es un software que realiza análisis sobre mecanismos. Se compone de varios 

módulos que permiten hacer simulaciones del funcionamiento por medio de 

animaciones, realizar análisis de vibraciones, realizar análisis de esfuerzos y más.  

La plataforma MSC Adams/Car es utilizado para simulación dinámica de un automóvil. 

El software Adams Car permite diseñar y simular vehículos para maximizar su 

rendimiento. Con este programa, se puede construir y probar rápidamente prototipos 

virtuales funcionales de vehículos completos y subsistemas de vehículos. Reduciendo 

así costos en tiempo, producción y análisis que un ensayo físico-destructivo supondría.  

Más específicamente Adams Car puede: 

 Modelar y diseñar o importar los subsistemas y ensamblajes que componen un 

vehículo. 

 Analizar mediante diferentes métodos los comportamientos de los ensamblajes 

y simular maniobras de subsistemas como suspensiones y dirección o del 

vehículo ensamblado. 
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Además, cuenta con una vasta biblioteca de ensamblajes, subsistemas y restricciones 

que son fácilmente ajustables al modelo que se quiera estudiar.  

Para poder realizar este trabajo, utilizaremos este programa para poder realizar el 

análisis y la simulación de las suspensiones, la dirección y del vehículo completo. 
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4. Datos de partida 
 

Partimos de las medidas del Willys MB/Ford GPG y sus componentes han sido 

obtenidas de manuales oficiales y otros documentos acreditados encontrados en la 

Web, los cuales se encuentran adjuntados en los Anexos I y II.  

Gracias al manual citado, hemos obtenido el peso total del vehículo, pero no el de cada 

uno de los subsistemas que lo compone. Por lo que hemos optado por realizar una 

aproximación que nos permita acercar el comportamiento del vehículo a la realidad. 

Al igual que con los pesos de los subsistemas, algunas medidas y los momentos de 

inercia, no nos ha sido posible encontrar sus valores detallados, por lo tanto, nos hemos 

ayudado de los planos oficiales, medidas realizadas a un modelo real o de cálculos 

aproximados. 

Debido a todo esto, el comportamiento de nuestro modelo en MSC Adams Car será una 

aproximación al modelo real del Willys MB/Ford GPW.  
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5. Modelado del Willys MB/Ford GPW (Jeep) 
5.1. Introducción 

 

El modelado del vehículo Willys MB/Ford GPW (Jeep) en el Adams Car, se realizará a 

partir de una aproximación del modelo real.  

Conociendo los datos geométricos y mecánicos del automóvil realizamos 

modificaciones o ajustes en los archivos del programa MSC Adams Car creando así la 

aproximación del modelo real.  Haciendo uso del modo “Template Builder” creamos o 

modificamos plantillas, necesarias para modelar el vehículo, que, posteriormente en el 

modo “Standard Interface”, en base a estas plantillas, creamos los subsistemas. 

Una vez creados los subsistemas, ensamblaremos el vehículo con la herramienta “Full 

Vehicule Assembly”. Y ya habiendo asegurado su correcto funcionamiento podremos 

proseguir con la simulación dinámica del vehículo. 

 

 

5.2. Carrocería 

5.2.1. Introducción teórica 
La carrocería es uno de los subsistemas más importantes del vehículo. Aquel que está 

conformando la estructura del vehículo, donde viajan los pasajeros y donde se sitúa la 

carga y otros subsistemas. Por ello, este subsistema es del cual depende en gran medida 

la seguridad e integridad de los pasajeros y del resto del vehículo. 

La carrocería, como podremos observar a continuación, soportará diversas fuerzas y 

solicitaciones, ya que, estará unido mediante anclajes y otras conexiones a diferentes 

subsistemas como son las suspensiones y el motor. 

 

 

Figura 14: [5-1] Carrocería de un vehículo – Estructura (Ref. 11) 
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5.2.2. Modelado de la Carrocería 
Para realizar el modelado de la carrocería del Willys MB/Ford GPW, partimos del 

modelo en 3D del vehículo provisto por el docente tutor Josep Lluís Suñer, el cual es un 

archivo en formato (.stp) de SolidWorks. Que procede de un repositorio público 

“GrabCAD” realizado por el autor Jeff Anderson. 

 

 

Figura 15: [5-2] Modelo de Willys MB en SolidWorks 

 

Ya que, este modelo 3D está realizado a escala real, no habrá necesidad de re escalar el 

diseño. Por lo que empezamos abriendo el archivo del modelo en SolidWorks y lo 

separamos en tres archivos diferentes. Uno que solo esté compuesto del chasis, es decir 

eliminando los otros subsistemas como son: ruedas, motor, suspensiones, dirección, 

etc.; otro que solo contenga el motor y por último uno de las ruedas (delanteras o 

traseras). 

 

 

Figura 16: [5-3] Modelo de la carrocería del Willys MB en SolidWorks 
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Figura 17: [5-4] Modelo del motor del Willys MB en SolidWorks 

 

 

Figura 18: [5-5] Modelo de una rueda  del Willys MB en SolidWorks 

 

Una vez creados los archivos, para poder importarlos a Adams Car, los guardamos en 

formato Parasolid (.x_t), dado que este es más compatible con Adams Car.  

Teniendo el modelo de la carrocería guardado en el formato adecuado, abrimos Adams 

Car en el modo Template Builder. Abrimos este modo, dado que permite al usuario 

crear, modificar y ajustar las plantillas que, una vez terminadas formarán los 

subsistemas del vehículo. Hay que tomar en cuenta que toda modificación que se haga 

en alguna plantilla o subsistema, por defecto de Adams Car, se almacenará en la carpeta 

Private.cdb. Por lo que una vez creadas las plantillas haremos uso de esta base de datos 

para almacenar nuestros avances. 

Para obtener la plantilla de la carrocería del Willys MB/Ford GPW, abrimos una 

plantilla modelo que nos proporciona Adams Car, de una camioneta 4x4 (Pickup), 

mediante la operación File > Open > Template > (Template Name >> Clic Derecho) > 

Search > acar_concept > _rigid_chassis_pickup.tpl.  
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Figura 19: [5-6] Modelo en Adams Car de la camioneta 4x4 (Pickup) 

 

Una vez abierto el modelo, seleccionamos Tools > Adams View Interface, en este modo 

procedemos a eliminar todos aquellos solidos que componen la carrocería del Pickup, 

realizamos la operación Bodies > ges_chassis > Edit > Delete. Seguido de esta operación 

importamos el archivo en Parasolid de la carrocería del Willys MB. Para ello accedemos 

a File > Import, se abrirá una pestaña como la de la Figura 20 de donde seleccionamos 

File Type > Parasolid, y en File to Read seleccionamos nuestro modelo, archivo que 

preferiblemente se lo debe de tener almenando en el escritorio y con un nombre que 

no contenga espacios ni tildes o caracteres extraños, cambiamos Model Name por Part 

Name, seleccionamos Part > Guesses > ges_chassis, y por último, con la herramienta de 

Edit > Move > (PSMAR) ajustamos la posición y la orientación del chasis. 

 

 

Figura 21: [5-7] Importación del modela de la carrocería 
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Y para acabar en el modo Template Builder, guardamos el archivo realizando la 

operación File > Save As > Template y la damos el nombre de “Jeep_WMB_Body” 

seleccionando en Minor Role > body. 

 

 

Figura 22: [5-8] Plantilla de la carrocería y ventana de guardado 

 

Posteriormente con la plantilla del chasis ya terminada, cambiamos al modo Standard 

Interface y creamos el subsistema correspondiente a esta. Para ello, realizamos la 

operación File > New > Subsystem, seleccionamos la plantilla de la base de datos 

private.cdb, le asignamos el nombre “Jeep_WMB_Body” y en Minor Role seleccionamos 

Any. 

Ya creado el subsistema en el modo Standart, siendo que tenemos una geometría de 

chasis diferente a la de la plantilla original, debemos cambiar la posición de los 

Hardpoints que, serán los puntos de referencia en el chasis para los siguientes 

subsistemas una vez ensamblado el modelo, puntos que muchas veces definen la 

geometría de un subsistema. Para ello seleccionaremos Adjust > Hardpoints > Table. Y 

una vez abierta la pestaña modificamos los Hardpoints de la siguiente manera. 
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Figura 23: [5-9] Posición de los Hardpoints de la carrocería 

 

Por último, solo queda asignar y cambiar los datos característicos de los momentos de 

inercia y el peso correspondiente a la carrocería.  Pero dado que no contamos con los 

datos de pesos y geometrías especificas necesarias para obtener los momentos de 

inercia exactos, realizaremos una aproximación a estos. De modo que tomaremos la 

carrocería como un paralelogramo de medidas conocidas y así junto con el peso 

conocido de la carrocería como conjunto, obtendremos los momentos de inercia. 

Tomando las siguientes ecuaciones. 

𝐼𝑥𝑥 =
1

12
∗ 𝑀𝑎𝑠𝑎 ∗ (ℎ2 + 𝑎2) 

𝐼𝑦𝑦 =
1

12
∗ 𝑀𝑎𝑠𝑎 ∗ (𝑙2 + ℎ2) 

𝐼𝑧𝑧 =
1

12
∗ 𝑀𝑎𝑠𝑎 ∗ (𝑎2 + 𝑙2) 

 

Y los datos de la carrocería como: 

 Altura (h) = Altura total (sin capota) – radio de rueda = 1321 – 355 => 966mm 

 Ancho (a) => 1575mm 

 Largo (l) => 3359mm 
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 Masa = Masa en orden de marcha (incluyendo gasolina y agua) – Masa del motor 

– Masa del resto del coche (ruedas, suspensiones, etc.) = 1113 - 73 - 140 => 

900Kg  

 

Con lo que nuestras inercias resultarían tal que: 

𝐼𝑥𝑥 =
1

12
∗ 900 ∗ (9662 + 15752) = 2.560336 ∗ 108𝐾𝑔𝑚𝑚2 

𝐼𝑦𝑦 =
1

12
∗ 900 ∗ (33592 + 9662) = 9.162028 ∗ 108𝐾𝑔𝑚𝑚2 

𝐼𝑧𝑧 =
1

12
∗ 900 ∗ (15752 + 33592) = 10.322629 ∗ 108𝐾𝑔𝑚𝑚2 

 

Y con los resultados obtenidos, introducimos los valores en el subsistema, realizando la 

operación Browse > Parts > ges_chassis > Modify, cambiamos los valores en las casillas 

correspondientes y pulsamos “OK”. 

 

 

Figura 24: [5-10] Masa e inercias de la carrocería 

 

Finalmente guardamos los cambiamos realizados al subsistema en la base de datos 

privada. 
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5.3. Motor y transmisión 

5.3.1. Introducción teórica 
Un motor es una máquina capaz de hacer funcionar el vehículo, transformando algún 

tipo de energía (eléctrica, de combustibles fósiles, etc.), en energía mecánica capaz de 

realizar un trabajo. Un trabajo que en los vehículos produce el movimiento. 

El motor que utiliza nuestro Willys MB/Ford GWP es el Willys L134 que tiene el 

sobrenombre de “Go Devil” un motor convencional a gasolina de 4 cilindros en línea, L-

head (Culata en L), con 2200 centímetros cúbicos de cilindrada, Potencia neta de 54 [cv] 

a 4000 [rpm] y tipo de combustión interna. El motor con el embrague, transmisión y 

transfer está construido como una unidad de potencia y montado sobre cuatro apoyos 

en el chasis. Y en cuanto a la transmisión el Jeep posee 3 velocidades, con una caja 

transfer que provee velocidades adicionales para atravesar terrenos dificultosos. 

Información que hemos obtenido de los planos oficiales que podemos encontrar en el 

anexo. 

 

 

Figura 25: [5-11] Go Devil L-134 – Motor Willys MB (Ref. 12) 

 

Respecto a la curva del motor, hemos encontrado algunas gráficas y tablas de potencias 

útiles que están de acuerdo con la infurción verificada de las guías técnicas del motor 

que tenemos. Tablas que estarán adjuntas en el anexo. 
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5.3.2. Modelado del Motor 
Para el modelado del motor, partimos del modelo en SolidWorks del mismo, empezando 

por importar en Adams Car este modelo. De esta manera primero abrimos el programa 

Adams Car en el modo Template Builder y abrimos el motor del Pickup, seleccionando 

File > Open > Template > Template Name > Search > acar_concept > 

_engine_transmission_tpl. El siguiente paso, tal y como hicimos con el chasis, será 

eliminar los sólidos de este archivo que no nos sirven, para posteriormente importar 

sobre este nuestro modelo del motor. Haciendo uso de la herramienta Edit > Delete y 

posteriormente pulsando File > Import y cargando el modelo del motor del Jeep en File 

to Read, cambiando Model Name por Part Name > ges_powertrain y con File Type: 

Parasolid. Por último, con la herramienta de Edit > Move > (PSMAR) ajustamos la 

posición y orientación del motor. 

  

 

Figura 26: [5-12] Plantilla del motor importado 

 

Guardamos la plantilla como “Jeep_WMB_engine_transmission” y por consiguiente 

cambiando al modo Standard Interface, creamos el subsistema ligado a dicha plantilla. 

Realizando la operación File > New > Subsystem y le asignamos el nombre de 

“Jeep_WMB_Powertrain”, con Minor Role > Any y cargando la plantilla recién creada.  

Una vez creado el subsistema, modificaremos las propiedades del motor, de modo que 

se aproxime más a nuestro modelo. Para ello habrá que modificar las curvas del motor, 

la relación de marchas y velocidad final. Por tanto, en el modo Standard Interface y con 

el subsistema abierto pulsamos Adjust > Powertrain Properties y seleccionamos la 

pestaña Transmission dentro de Powertain Configuration > Manual Gear Shifting. Y 

comenzamos modificando las marchas de acuerdo a la información correspondiente al 

modelo.  
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Dónde la relación de transmisión para cada velocidad es: I - 2,665, II - 1,564, III - 1,0, 

retro - 3,554 

 

 

Figura 27: [5-13] Powertrain Parameters – Relación de transmisión del motor 

 

Posteriormente, modificaremos los parámetros de funcionamiento del motor, 

velocidades de giro y curvas del motor. Para ello creamos una copia de archivo de 

Property File dentro de la pestaña Engine, y la guardamos en la base de datos privada 

como JeepEngineTransmission. Luego, una vez hecha la copia la modificamos con un 

editor de texto. Y copiamos la tabla de potencias que hemos encontrado (las cuales se 

muestran en el Anexo II) en las unidades correspondientes. La verificamos sabiendo 

que el Willys MB acelera de 0 a 97Km/h en 15 segundos con velocidad máxima de 105 

Km/h.  

 

 

Figura 28: [5-14] Powertrain Parameters – propiedades y curva del motor 
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Figura 29: [5-15] Fichero de la curva del motor 

 

Una vez editado, verificamos si las curvas son correctas, pulsando en Power/Velocity 

Plot para ver la gráfica de estas. 
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Figura 30: [5-16] Grafica de potencia vs velocidad del motor 

 

Una vez verificado, deberemos asignarle un peso y unos momentos de inercia al motor. 

Pero ya que no contamos con la información exacta requerida, la aproximaremos tal y 

como hicimos con el chasis. De manera que, los cálculos y datos utilizados son: 

 Altura (h) => 655mm 

 Ancho (a) => 418mm 

 Largo (l) => 542mm 

 Masa Motor=> 73 Kg  

Con lo que nuestras inercias resultarían como. 

𝐼𝑥𝑥 =
1

12
∗ 73 ∗ (6552 + 4182) = 3.672806 ∗ 106𝐾𝑔𝑚𝑚2 

𝐼𝑦𝑦 =
1

12
∗ 73 ∗ (5422 + 6552) = 4.396966 ∗ 106𝐾𝑔𝑚𝑚2 

𝐼𝑧𝑧 =
1

12
∗ 73 ∗ (4182 + 5422) = 2.849969 ∗ 106𝐾𝑔𝑚𝑚2 

 

Finalmente, con los resultados obtenidos, introducimos los valores al subsistema, 

realizando la operación Browse > Parts > ges_powertrain > Modify, cambiamos los 

valores en las casillas correspondientes y pulsamos “OK”. 
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Figura 31: [5-17] Masas e inercias del motor 
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5.4. Suspensión delantera y trasera 

5.4.1. Introducción teórica 
El sistema de suspensión de un vehículo es el conjunto de componentes mecánicos que 

unen la parte suspendida del vehículo con la no suspendida, con el objetivo primordial 

de mantener las ruedas en contacto con el terreno, absorbiendo las vibraciones, 

irregularidades del terreno y movimientos provocados por las ruedas en el 

desplazamiento de vehículo. De manera que se consiga una mayor comodidad a los 

ocupantes del vehículo y, por otra parte, un mayor control y seguridad dado que toda 

suspensión va a contribuir a mejorar la estabilidad del vehículo, mejorando la 

adherencia y la respuesta de la dirección.  

En todo vehículo se pueden distinguir dos grandes grupos en los elementos que lo 

componen: 

• La Masa Suspendida: que es la parte de la masa del vehículo que es soportada por el 

sistema de suspensión. Estaría constituida por el chasis, grupo motor, carrocería, etc., 

además de la carga y ocupantes del vehículo. 

• La Masa No Suspendida: que es la formada por el sistema de suspensión y los 

elementos que conectan dicho sistema con el terreno. E nuestro caso son las ruedas, 

frenos del vehículo, elementos de transmisión, ejes, etc. 

 

Por parte del sistema de suspensión en los vehículos automóviles tiene dos cualidades 

fundamentales: la elasticidad, para evitar golpes secos en el chasis debido a las 

irregularidades del terreno; y la amortiguación, que impida un excesivo balanceo de los 

elementos de la suspensión que se transmita al resto del vehículo. 

Ahora bien, existen diferentes tipos de suspensiones al día de hoy, con formas y 

disposiciones variadas. En nuestro caso, el vehículo que estudiamos, hace uso de una 

suspensión de ballesta de tipo semi-elíptica.  

 

La suspensión de ballesta es un sistema de amortiguación empleada en vehículos. Su 

función se podría resumir como la de un muelle plano que permite una gran variedad 

de formas de instalación. 

Las ballestas en particular son un tipo de resorte constituido por un conjunto de hojas 

o láminas superpuestas fabricadas en acero de la misma composición, que es empleado 

para los muelles helicoidales en otros sistemas de suspensión, es decir, aleado con 

silicio y manganeso. Unidas en el centro por un tornillo pasante con tuerca, llamado 

"capuchino" y que se mantienen alineadas por una serie de abrazaderas que evitan que 

se abran en abanico, y a la vez permiten el deslizamiento entre las hojas cuando éstas 

se deforman debida a la carga, formando todo ello un conjunto elástico de gran 

resistencia a la rotura. En la actualidad se suelen utilizar en los sistemas de suspensión 
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de vehículos pesados (camiones, furgonetas), remolques y en vehículos 4x4, entre 

otros. 

 

 

Figura 32: [5-18] Ejemplo de ballesta (Ref. 13) 

 

La hoja superior y más larga, llamada hoja maestra, va curvada en sus extremos 

formando una especie de "ojos" para introducir en ellos unos casquillos, que sirven para 

alojar los pernos o bulones que anclan la ballesta al soporte del bastidor del vehículo 

formando articulaciones. 

Las hojas que conforman la ballesta se deforman debida a las desigualdades del terreno 

y la carga del vehículo, de manera que las hojas tienden a ponerse rectas al deformarse, 

por ejemplo, cuando la rueda pasa por encima de cualquier irregularidad del terreno. 

Por este motivo, la forma de realizar el anclaje de la ballesta al chasis deberá disponer 

de un sistema que permita su alargamiento. 

Este sistema consiste en realizar la unión de la ballesta al bastidor del vehículo 

mediante el empleo de dos tipos de apoyo distintos, uno fijo articulado mediante un 

perno pasador y otro móvil, realizado por medio de una pieza intermedia llamada 

gemela que se ancla al chasis por medio de un tornillo pasante. 

 

 

Figura 33: [5-19] Partes de una ballesta y funcionamiento (Ref. 13) 
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Con esta disposición se permite aumentar o disminuir la longitud de la ballesta 

favoreciendo los movimientos de flexión de sus hojas. Generalmente el apoyo móvil se 

coloca en la parte trasera de la ballesta. 

 

 

Figura 34: [5-20] Gemela montada en una ballesta del Willys MB  (Ref. 14) 

 

Esta solución constructiva en el montaje de la ballesta admite el alargamiento de las 

hojas que conforman la ballesta y las variaciones de curvatura, que se producen por las 

oscilaciones a que está sometida durante la marcha del vehículo. 

 

Con la continua aparición cada vez de nuevos materiales con mejores prestaciones, la 

tendencia actual en las ballestas es a tener menos hojas y que sean menos curvas, 

llegando a fabricarse en la actualidad modelos de ballestas de una sola hoja fabricada 

de materiales compuestos, que pueden reducir en gran medida el problema del peso de 

la suspensión y el de la fricción entre hojas. 

La principal característica de las ballestas es su elevada rigidez para soportar carga, 

cuyo valor va a depender del espesor y ancho de las hojas, así como del número de hojas 

utilizadas. La rigidez de las ballestas es lineal en relación al desplazamiento de la rueda, 

por lo que a cada ballesta se le puede asignar una constante de rigidez, que se calcula 

de diferente modo según el tipo y configuración de la ballesta. 

 

Durante muchos años, decir suspensiones de un automóvil significaba decir ballestas; 

éstas se empleaban en los ejes rígidos, en los puentes De Dion, en las suspensiones 

independientes, etc., siguiendo el desarrollo técnico. Las disposiciones que se 

emplearon iban desde el tipo normal hasta el semicantiléver y cantilever: del tipo 

semielíptico al de un cuarto de elipse, con todas las combinaciones posibles (tipo 

elástico, tres cuartos de elipse, etc.). 

La diferencia principal entre las suspensiones por ballestas y las de los demás tipos 

consiste en que las primeras pueden reunir, además de una función meramente elástica, 
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otras de guiado de las ruedas con relación al bastidor o a la carrocería y de 

amortiguamiento de las oscilaciones de la masa suspendida. Entendida como órgano 

elástico, la ballesta es un muelle de acero que trabaja por flexión y puede suponerse que 

deriva de una viga de resistencia uniforme. Cuando la anchura es constante, en las 

secciones próximas al punto de aplicación de la fuerza de solicitación es menor y, por 

tanto, el material resulta poco aprovechado. En cambio, en la configuración triangular 

todo el material resulta igualmente solicitado y se consigue con ello el mínimo peso del 

muelle. 

La capacidad de amortiguamiento de una ballesta deriva de las fuerzas de rozamiento 

que se generan a consecuencia del deslizamiento entre sus hojas. Si bien en los primeros 

tiempos este rozamiento era útil, posteriormente, con la aparición de amortiguadores 

efectivos, se trató de eliminarlo; en efecto, al tratarse de rozamiento de tipo seco, es 

decir, independiente de la magnitud de los movimientos, las ballestas quedarían 

bloqueadas cuando se pasase sobre irregularidades pequeñas. Esto trae consigo 

deficientes características de confort y un ruido molesto. Por ello se requiere un 

mantenimiento frecuente, consistente en una lubricación a base de aceite y grafito. Para 

eliminar estos inconvenientes se adoptan también soluciones de hoja única o de pocas 

hojas. 

 

 

5.4.2. Modelado de la Suspensión delantera 
La suspensión delantera podría llegar a ser, no tan solo el subsistema más importante 

sino, incluso, el subsistema sobre el cual se ha trabajado con más detalle y el que más 

peso y relevancia tiene en este trabajo. Ya que, para modelar este subsistema hemos 

tenido que crear una aplantilla a partir de otras dos diferentes y así poder obtener el 

resultado requerido. La base de datos de platillas de Adams Car no cuenta a estas fechas 

con un vehículo de tracción integral que cuente con suspensiones de ballesta tanto 

delantera como trasera, por este motivo hemos tenido que combinar las suspensiones 

de un camión y la de una camioneta 4x4 (Pickup). 

 

Por un lado, el camión, si bien lleva suspensiones de ballesta delantera y trasera no lleva 

tracción integral y además tiene un tamaño mucho mayor al del Willys MB. Algo que a 

la hora de dimensionar la geometría hallaríamos dificultades en subsistemas como la 

dirección. Y por otro lado tenemos el Pickup que, si bien, solo lleva la suspensión trasera 

de ballesta, lleva tracción integral y además tiene un tamaño muy similar al de nuestro 

vehículo.  

Ahora si tan solo hubiésemos utilizado la suspensión delantera del camión que es la que 

lleva una suspensión delantera de ballesta, y la ensamblamos con el resto del vehículo, 

que está basado en el modelo del Pickup, está no habría sido compatible con el resto del 

vehículo. Especialmente habríamos tenido problemas al ensamblarse en conjunto con 
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la dirección, las ruedas delanteras y sobre todo con el palier (driveline); ya que estos 

llevan conexiones importantes para el funcionamiento del coche, conexiones que la 

suspensión del camión no lleva. Y por otro lado la suspensión delantera del Pickup lleva 

una suspensión de barras de doble torsión, por lo que, mecánicamente hablando no es 

compatible con la suspensión de ballesta.  

 

 

Figura 35: [5-21] Modelo de la suspensión delantera del Pickup 

 

 

Figura 36: Modelo del Pickup en vista esquelética 
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Figura 37: [5-22] Ensamblado de la suspensión delantera del camión 

 

Es por esto que hemos planteado una solución hibrida que trata de crear un subsistema 

compatible con el resto de subsistemas del automóvil y que además tenga las 

propiedades mecánicas de la suspensión del Willys MB. Así, partimos de la suspensión 

delantera del Pickup, la “double whishbone torsion”, para mantener la mayor cantidad 

de conexiones y subestructuras que necesitamos. Luego borraremos las partes que no 

nos son necesarias en una suspensión de ballesta, las barras de torsión esencialmente. 

Para luego crear las barras, cojinetes, conexiones y pares de revolución necesarios para 

que se comporte como la suspensión de ballesta que deseamos.  
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De esta manera, en el modo “Template” de “Adams Car” abrimos la platilla de la 

suspensión delantera del Pickup: File > Open > Template > Search > acar_concept > 

_double_whishbone_torsion.tpl.  

 

 

Figura 38: [5-23] Plantilla del Double Wishbone Torsion – Suspensión delantera del Pickup 

 

Una vez abierta nos dedicaremos a borrar las barras que no necesitamos como lo 

hicimos en subsistemas previos. Seleccionamos Tools > Adams View Interface, y para 

eliminar todos aquellos solidos que no necesitamos del Pickup realizamos la operación 

Bodies > ges_chassis > Edit > Delete. Borramos las barras inferiores y superiores que 

componen la barra de torsión.  

 

 

Figura 39: [5-24] Plantilla de la suspensión delantera del Pickup con la barras de torsión eliminadas 
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Ahora, en el modo Template creamos dos Hardpoints, uno para el punto central del que 

vendrá siendo nuestro eje y otro para sus extremos que se conectará a las barras 

upright que son los que se conectan al movimiento de las ruedas. Para ello 

seleccionamos Build > Hardpoint > New. Aparecerá una pestaña la cual habrá que 

rellenar de las siguientes maneras. 

 

   

Figura 40: [5-25] Hardpoint: axle_center y  Figura 41: [5-26] Hardpoint: axle_1 

 

 

Figura 42: [5-27] Plantilla de la suspensión delantera del Pickup representado los Hardpoints creados 

 

Una vez creados los puntos, creamos el eje. Para ello habremos de seleccionar Build > 

Parts > General Part > New y rellenaremos la ventana que se muestra a continuación de 

la siguiente manera.  
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Figura 43: [5-28] Creación del General Part: axle 

 

Ahora que tenemos el “Part” crearemos la representación física del eje. Par esto 

seleccionamos Build > Geometry > Link > New. Y rellenaremos la ventana que aparece 

como se muestra a continuación. 
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Figura 44: [5-29] Creación del Link: axle 

  

Luego de esto creamos un “joint” en el centro del eje, seleccionando Build > Attachments 

> Joint > New, rellenando la pestaña como se muestra a continuación. 

 

  

Figura 45: [5-30] Creación del Joint central: axle 
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Luego creamos un par de revolución, justo en el punto “axle_1” que creamos 

anteriormente, que se encargara del movimiento que relaciona el eje y las barras 

“upright” que están conectadas a las ruedas. Y orientaremos este par de revolución lo 

más similar posible a como estaba orientado en la suspensión del “doublé wishbone 

torsion”, por ello utilizaremos los puntos “uca e ica outer” para su orientación. Para 

crear el par de revolución debemos seleccionar Build > Attachment > Joint > New, y 

rellenar los espacios de la pestaña como se muestra a continuación.  

 

 

Figura 46: [5-31] Creación del Joint de revolución: upright_to_axle 

 

Ahora nos dedicamos a crear los cojinetes inferiores de los amortiguadores, ya que 

estos fueron eliminados al borrar las barras inferiores y superiores de la “doublé 

wishbone torsion”. Para ello seleccionamos Build > Attachments > Bushings > New, una 

vez seleccionada la casilla de “new bushing” aparecerá una ventana que habrá que 

rellenarla como se muestra a continuación. 
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Figura 47: [5-32] Creación del Bushings inferiores de los amortiguadores 

 

También crearemos el punto de unión del amortiguador en el sitio en que vendrán 

apoyadas las ballestas, para ello habrá que crear primero un par de puntos llamados 

“leafspring_front_axle” luego un “construction frame”, un “mount part” y finalmente el 

“joint” que estábamos buscando. Por lo tanto, empezamos seleccionando Buil > 

Hardpoint > New, y rellenamos las casillas como se muestra a continuación.  

 

 

Figura 48: [5-33] Creación del Hardpoint leafspring_front_axle 
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Una vez credos el par de puntos seguimos y realizamos la operación Build > 

Construction Frame > New, y rellenamos las casillas de la ventana como se muestra a 

continuación. 

 

 

Figura 49: [5-34] Creación del Construction Frame: leaf_to_axle 

 

A continuación, creamos el “mount part”, seleccionamos Build > Parts > Mount > New, y 

rellenamos la ventana como se muestra a continuación. 

 

 

Figura 50: [5-35] Creación del Mount Part: leaf_to_axle 
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Finalmente, teniendo todo lo necesario para crear el “joint” que une las ballestas a la 

suspensión, seleccionamos Build > Attachment > Joint > New, y rellenamos las casillas 

de la ventana como se muestra continuación. 

 

 

Figura 51: [5-36] Creación del Joint: leaf_to_axle 

 

Además, habrá que crear un parámetro que, antes al eliminar las barras de torsión 

hemos eliminado y será necesario para el comportamiento de la suspensión, un 

“Suspension Parameters Array”. Para ello no iremos a Build > Suspension Parameters > 

Characteristics Array > Set…, Y rellenaremos la ventana como se muestra a 

continuación. 
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Figura 52: [5-37] Creación del Suspension Parameter Array de la suspensión delantera 

 

Una vez realizados todos estos cambiamos, nuestra platilla debería quedar tal como se 

muestra en la imagen a continuación.  

 

 

Figura 53: [5-38] Plantilla terminada de la suspensión delantera 

 

Una vez terminada la plantilla la guardamos como “Jeep_WMB_double_wishbone_leaf” 

con Minor Role > suspension. Y cambiamos de modo al modo Standart para crear el 

subsistema correspondiente a esta plantilla. El cual nombraremos como 

“Jeep_WMB_Front_Suspension”. 

Por último, moveremos algunos “Hardpoints” de modo que nuestro vehículo se 

comporte de la manera requerida y se ajuste a la anchura de nuestro vehículo. Además, 
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para ajustar los ángulos de caída y convergencia que tendrá nuestro coche, hemos 

modificado la posición del par de puntos “tierod_outer” de manera que los ángulos estén 

en un rango razonable. Con este propósito seleccionamos Adjust > Hardpoint > Table, y 

modificamos la tabla como se muestra continuación.  

 

 

Figura 54: [5-39] Posición de los Harpoints de la suspensión delantera 

 

Finalmente guardamos los cambios realizados en el subsistema. 
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5.4.3. Modelado de la Ballesta delantera 
Para el modelado de la ballesta delantera hay que tener en cuenta que esta es la primera 

vez que hacemos uso de un subsistema como este. Y que por la naturaleza del automóvil 

esta viene a ser una parte esencial del vehículo. Tras una serie de pruebas y errores 

finalmente averiguamos como modificar una ballesta a gusto y a ajustar su geometría 

para poder aproximarla a la real. Es a raíz de este subsistema que utilizamos una 

camioneta 4x4 que hace uso de al menos una suspensión basada en ballesta.  

De esta manera utilizamos el subsistema de la ballesta trasera de la camioneta 4x4 

(Pickup) en Adams Car. En el modo “Standart” seleccionamos File > Open > Subsystem > 

Search > acar_concept > leafspring_rear.sub. 

 

 

Figura 55: [5-40] Modela del subsistema de la ballesta trasera del Pickup 

 

 Y una vez abierto el subsistema, el siguiente paso será modificar los “Hardpoints” de 

modo que cuando apliquemos el cambio de geometría para las placas de la ballesta esta 

pueda reconstruirse en la orientación y posición indicada, y adecuada para su propia 

geometría. Esto es importante ya que, sí empezamos modificando las longitudes de las 

placas de las ballestas antes de posicionar los puntos de los extremos de la ballesta, el 

rango en que esta se pueda curvar de acuerdo con sus restricciones, no será adecuado 

y la ballesta no se regenerará dándonos como resultado una alerta de error. Para ello 

seleccionamos Build > Hardpoints > Table, y modificamos los puntos tal como se 

muestra a continuación. 
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Figura 56: [5-41] Posición de los Hardpoints de la ballesta delantera 

 

Con lo que recién pasamos a modificar la propia ballesta. Seleccionamos Adjust > Leaf 

Springs. Una vez abierta la pestaña nos vamos al archivo que genera la ballesta lo 

copiamos y lo guardamos en nuestra base de datos cambiándole el nombre. Para ello 

nos vamos a la casilla que se muestra a continuación y presionamos click derecho, 

seleccionando Search > acar_concept/leafsprings.tbl, y copiamos el archivo “simple.ltf” 

que aparecerá en la carpeta abierta. Volvemos a realizamos la anterior operación, pero 

esta vez abrimos la base de datos privada “private/leafspring.tbl” y pegamos el archivo 

copiado, cambiándole el nombre a “Jeep_WMB_Leafspring”, seleccionamos el archivo y 

presionamos “OK”. 

 

 

Figura 57: [5-42] Modify Leaf Spring – archivo de propiedades 
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Una vez guardada la editamos. Abrimos nuevamente la pestaña de “Modify Leaf Spring” 

y presionamos en el botón de “Edit the leaf spring property file” que se muestra a 

continuación. Aparecerá una venta que nos permite modificar las geómetras y 

propiedades de las ballestas.   

 

 

Figura 58: [5-43] Modify Leaf Spring – editor del archivo de propiedades 
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Figura 59: [5-44] Editor de propiedades de la ballesta 

 

En la ventana anterior seleccionamos “Leaves” y modificamos esa pestaña como se 

muestra a continuación. Lo cual cambiará la geometría de la ballesta a como la 

necesitamos para que se pueda ensamblar en nuestro vehículo. 

 

 

Figura 60: [5-45] Editor de propiedades de la ballesta – formulario de las hojas de la ballesta 

 

Guardamos el editor, presionando en el botón de “save” y luego “OK” en la ventana de 

“Modify Leaf Spring”. Se habrá regenrado el subsistema y quedará como se muestra a 

continuación.  



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

66 

 

Figura 61: [5-46] Subsistema de las ballestas delanteras terminada 

 

Por último, guardamos el subsistema como “Jeep_WMB_Front_Leafspring” con Minor 

Role > Front. 

 

 

5.4.4. Modelado de la Suspensión trasera 
Para la suspensión trasera, a diferencia de la suspensión delantera no habrá que crear 

un nuevo subsistema. De hecho, se podría decir que en conjunto con el subsistema del 

palier (driveline) este subsistema es una de las razones por la cual se eligió de base el 

modelo del Pickup en Adams Car. Ya que la suspensión trasera de esta es sumamente 

parecida a la del Willys MB. 

Por lo que comenzamos abriendo el subsistema de la suspensión trasera del Pickup: 

File > Open > Subsystem > Search > acar_concept > solid_axle_rear.sub. Una vez abierto 

modificamos los “Hardpoints” para adecuarlos a nuestro vehículo. Seleccionamos Adjust 

> Hardpoint > Table, y modificamos la tabla como se muestra a continuación. 
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Figura 62: [5-47] Posición de los Hardpoints de la suspensión trasera 

 

Y por último, guardamos el subsistema en nuestra base de datos como 

“Jeep_WMB_Rear_Suspension” con Minor Role > Rear. 

 

 

Figura 63: [5-48] Subsistema de la suspensión trasera terminada 
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5.4.5. Modelado de la Ballesta trasera 
Para el modelado de la ballesta trasera, tan solo hay seguir la base de la ballesta 

delantera de modo que tengan las mismas características geométricas, tanto delanteras 

como las traseras. Ya que nuestro vehículo original las lleva de esta manera, algo que 

en la actualidad no se lleva teniendo en cuenta que las suspensiones delanteras y 

traseras se comportan distinto y soportan esfuerzos distintos. Pero ya que lo que se 

buscaba con este vehículo era la mayor simplicidad posible optaron por diseñarlas casi 

idénticas. 

De esta manera en el modo “Standart” abrimos el subsistema de la ballesta delantera 

que previamente creamos, seleccionando File > Open > Subsystem > Search > private > 

_Jeep_WMB_Front_Leafspring. Una vez abierto la guardamos con Save as para poder 

crear una copia de esta con selecionando Minor Role > Rear en vez de Front y 

guardándolo como “Jeep_WMB_Rear_Leafspring”. Hecho esto, finalmente, para 

posicionar las ballestas donde corresponden, modificamos los “Hardpoints” como se 

muestra a continuación. 

 

 

Figura 64; [5-49] Posición de los Hardpoints de la ballesta trsera 

 

 

Figura 65: [5-50] Subsistema de las ballestas traseras terminada 
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5.5. Dirección 

5.5.1. Introducción teórica 
El sistema de dirección es un conjunto de mecanismos cuya finalidad consiste en 

orientar las ruedas delanteras (o directrices) para que el conductor, sin esfuerzo, pueda 

variar la trayectoria del vehículo.  

Principalmente, el sistema de dirección está compuesto por una serie de elementos que 

funcionan del siguiente modo: el conductor controla la trayectoria del automóvil por 

medio del volante, lo que accionará la barra de dirección, que es la encargada de unirlo 

a la caja de dirección. 

La caja puede ser de diversos tipos, como de cremallera o de bolas recirculantes entre 

otras. En nuestro caso el vehículo de estudio lleva un sistema de dirección de bolas 

recirculantes, por lo que se compone de una biela que la unirá la caja a la varilla central.  

Solemos encontrar este tipo de sistema de dirección en vehículos pesados, buses y 

camiones. Recibe ese nombre ya que se compone de unas esferas encargadas de facilitar 

el movimiento suavizándolo. Lleva un gran tornillo que gira sobre sí mismo para 

desplazar los engranajes dentro de una caja con valvulina. 

 

 

Figura 66: [5-51] Sistema de dirección a base de bolas circulantes (Ref. 15) 

 

El sistema de dirección del vehículo entra en el grupo de elementos de seguridad del 

automóvil debido a la importancia de su labor, por lo que siempre debe procurar 

seguridad, suavidad, precisión y asegurar que las irregularidades del terreno no afecten 

o se transmitan al volante. 

 

 

5.5.2. Modelado de la Dirección 
Ahora, si bien conocemos el tipo de dirección que lleva nuestro vehículo, para mayor 

simplicidad y mayor compatibilidad con el resto del modelo, habremos de utilizar la 

dirección que utiliza nuestro modelo guía de Adams Car que es el de la camioneta 4x4 

(Pickup), una dirección de piñón y cremallera. Esta dirección aun siendo 
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mecánicamente distinta a la real podrá cumplir el papel necesario para poder 

aproximar el comportamiento de nuestro automóvil.   

De esta forma empezamos, en el modo Standard Interface, abriendo el subsistema de 

dirección del Pickup realizando la operación Open > Subsystem > Search > acar_concept 

>parallel_link_steering.sub Una vez abierto guardamos una copia idéntica en nuestra 

base de datos, asignándole el nombre de “Jeep_WMB_Steering” con Minor Role > Any. 

Posteriormente, deberemos modificar los “Hardpoints” de la dirección, abrimos la tabla 

de modificación de “Hardpoints”, seleccionamos Adjust > Hardpoint > Table y la 

modificaremos tal como tenemos la siguiente tabla. 

 

 

Figura 67: [5-52] Posición de los Hardpoints de la dirección 

 

 

Figura 68: [5-53] Subsitema de la dirección terminada 

 

Y, por último, una vez realizadas las modificaciones, guardamos el subsistema. 
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5.6. Driveline 

5.6.1. Introducción teórica 
La línea motriz, palier o Driveline es el subsistema atreves del cual se transmite el par 

motor a las ruedas del vehículo. Encargado de transmitir el movimiento desde la salida 

del diferencial hasta las ruedas, permitiendo la correcta función tanto de la suspensión 

como de las ruedas.  

La tracción de un coche indica a qué ruedas se transmite la potencia del motor. 

Habiendo 3 tipos de tracción: delantera, trasera e integral o 4x4, según cuáles sean las 

ruedas motrices. El tipo de tracción del coche determina precisamente este detalle, 

puede transmitirse directamente a las ruedas delanteras, a las traseras o a las cuatro. 

Dependiendo del tipo de tracción del vehículo algo que afecta directamente a 

características tan importantes como la manejabilidad o el consumo. 

En nuestro caso estamos estudiando un vehículo de tracción integral 4x4. Los 

tradicionales 4×4, los clásicos coches utilizados para ir por terrenos no aptos para la 

circulación se caracterizan precisamente por montar tracción integral que hace que sus 

cuatro ruedas sean motrices, disfrutando del máximo un agarre al suelo. Haciéndolo 

como era su propósito un vehículo con un alto rango de manejabilidad en terrenos 

difíciles. 

 

 

Figura 69: [5-54] Tracción integral (Ref. 16) 

 

La transmisión del motor del Pickup dirige su potencia a las cuatro ruedas, por lo que 

el control del vehículo en superficies complicadas o en condiciones donde se presente 

un agarre pobre por fenómenos como la lluvia o la nieve es mayor. 

Lo que también afecta a características como el frenado, siendo menos eficiente, y al 

peso, lo cual incrementa proporcionalmente su consumo. 
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5.6.2. Modelado del Driveline 
Entendiendo y conociendo la importancia e influencia que este subsistema tiene sobre 

el resto del vehículo, debemos tomar en cuenta que no contamos con las herramientas 

ni la experiencia suficientes para trabajar ni ajustar adecuadamente este subsistema.  

Siendo esta la primera vez que, en conjunto con el profesorado, se realiza un trabajo 

donde se maneja un vehículo con tracción total, hemos optado por trabajarlo y utilizarlo 

tal como viene del modelo base que utilizamos de los archivos de Adamas Car. 

Realizando la menor cantidad de modificaciones que podamos en orden de que se 

consiga un vehículo en funcionamiento. 

Con esta idea en mente abriremos en el modo Standart de Adams Car el archivo 

correspondiente, realizando la operación Open > Subsystem > Search > acar_concept > 

driveline_4wd.sub, una vez abierto modificamos algunos “Hardpoints” tal como muestra 

la siguiente tabla. 

 

 

Figura 70: [5-55] Posición de los Hardpoints del driveline 

 

 

Figura 71: [5-56] Subsistema del driveline terminado 

 

Y, por último, pasamos a guardarlo en nuestra base de datos como 

“Jeep_WMB_Driveline” con Minor Role > Any. 
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5.7. Ruedas frontales y traseras 

5.7.1. Introducción teórica 
Uno de los mecanismos de mayor relevancia en un vehículo son las ruedas. Debido a 

que son el elemento que conecta la calzada con el vehículo, compartiendo el 

funcionamiento de subsistemas como la dirección, suspensión entre otros. Son los 

elementos sobre los que se apoya el automóvil y las encargadas de dirigir, propulsar y 

detener el mismo. Compuesta por la llanta y los neumáticos. 

La rueda es una pieza metálica de alta precisión que van fijadas a una parte llamada 

buje en el centro de los discos o en los tambores de freno mediante tuercas o tornillos. 

La potencia del motor se puede transmitir a las ruedas delanteras (de tracción), a las 

ruedas traseras (de propulsión o tracción trasera), y a las ruedas delanteras y traseras 

a la vez (de tracción integral). Que en nuestro caso siendo un vehículo 4x4 sería de 

tracción integral. 

Las funciones principales de las ruedas son las siguientes: Transmitir los esfuerzos de 

tracción y frenado. Participar en la suspensión y confort del vehículo. Liberar el calor 

producido por el trabajo de los frenos y neumáticos. 

Existen diferentes denominaciones para los tipos de rueda según su función: 

Las ruedas motrices de un vehículo son aquellas que transmiten la fuerza, convirtiendo 

el par aplicado en la tracción o propulsión que ejercen los neumáticos sobre la calzada, 

haciendo que el vehículo se mueva. El sistema de propulsión entrega a las ruedas el par 

suficiente vencer la fuerza estacionaria, eso provoca que el vehículo se desplace hacia 

delante o hacia atrás. 

Lo más común en los vehículos es una tracción a las 2 ruedas o 2x2, en la que el 

movimiento se genera en el tren delantero o trasero únicamente. Aunque otros 

vehículos tienen una tracción integral a las cuatro ruedas, también llamada 4x4. 

Y las ruedas direccionales son aquellas que giran para modificar la trayectoria del 

vehículo. Las ruedas de rodadura no se consideran ruedas motrices ni direccionales. 

Los vehículos de tracción delantera, por ejemplo, suelen considerar sus ruedas traseras 

como “ruedas de rodadura”. 

 

 

5.7.2. Modelado de las Ruedas 
Para el modelado de las ruedas en Adams Car, utilizaremos los modelos de ruedas de 

SolidWorks correspondientes al Willys MB. Importaremos estos archivos como hicimos 

anteriormente con el chasis o el motor. Para ello empezaremos abriendo la Template de 

una de las ruedas del Pickup, seleccionando File > Open > Template > Search > 

acar_shared > _handling_tire.tpl. El siguiente paso, una vez abierta la plantilla tal y como 

hicimos con el chasis y el motor, será eliminar los sólidos de este archivo como son los 
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aros y los neumáticos, para posteriormente importar nuestro modelo sobre este. 

Haciendo uso de la herramienta Edit > Delete y posteriormente pulsando File > Import 

y cargando uno por uno cada modelo de las ruedas, delanteras o traseras, derecha e 

izquierda del Jeep en File to Read, con File Type: Parasolid y cambiando Model Name por 

Part Name > whl_wheel y whr_wheel correspondientemente. Por último, con la 

herramienta de Edit > Move (PSMAR) ajustamos la posición y orientación de las ruedas. 

Una vez importadas las ruedas, guardamos la plantilla como “Jeep_WMB_handling_tire”. 

Y apartir de esta plantilla creamos dos subsistemas en el modo Standard uno para las 

ruedas delanteras con Minor Role > Front y otro para las ruedas traseras con Minor Role 

> Rear. Guardandolos como “Jeep_WMB_Front_Wheel” y “Jeep_WMB_Rear_Wheel” 

respectivamente. 

 

 

Figura 72: [5-57] Subsistema de las ruedas delanteras terminada 

 

 

Figura 73: [5-58] Subsistema de las ruedas traseras terminada 
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5.8. Sistema de frenos 

5.8.1. Introducción teórica 
El sistema de frenado es un conjunto de piezas mecánicas que tienen como objetivo 

transformar la energía cinética, del movimiento de las ruedas en energía térmica con el 

fin de obtener una deceleración o bloquear el vehículo cuando se está estacionado. 

Además, los componentes que conforman los frenos deben de poder detener el vehículo 

pudiendo disipar el calor generado con una elevada eficacia. 

Existes una variedad de tipos de frenos para operar en un vehículo, de entre los cuales 

destacan los de freno de disco y de tambor. 

• Freno de disco: Un freno de disco es un dispositivo, basado en un disco y una pinza 

que ejerce presión sobre el anterior, cuya función es detener o reducir la velocidad de 

rotación de una rueda. Hecho normalmente de acero y que está unido a la rueda o al eje. 

Que es también el más utilizado en la actualidad. 

 

 

Figura 74: [5-59] Freno de disco (Ref. 17) 

 

• Freno de tambor: El freno de tambor es un tipo de freno en el que la fricción se causa 

por un par de zapatas o pastillas que presionan contra la superficie interior de un 

tambor giratorio, el cual está conectado al eje o la rueda. 
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Figura 75: [5-60] Freno de tambor (Ref. 18) 

 

El vehículo en cuestión utiliza un freno de tambor, como se puede observar en la 

fotografía. Uno que se compone de un tambor, unas zapatas o mordazas primaria y 

secundaria, un dispositivo de retención, unos muelles de retorno y cubiertas de zapata.  

 

 

5.8.2. Modelado del Sistema de frenos 
Como bien hemos indicado en la introducción teórica de este apartado, el modelo del 

Willys MB lleva un sistema de frenado de tambor. A pesar de ello, no hemos sido capaces 

de hallar dentro del catálogo de Adams Car un freno de tambor. Ni tampoco conocemos 

el proceso para crear un sistema de freno de tambor. Por lo que, en su lugar, partiremos 

de la hipótesis de que nuestro vehículo lleva freno de disco y aproximaremos su 

comportamiento al real tanto como nos sea posible. 

Empezamos, en el modo Standard Interface, abriendo el subsistema de frenos del 

Pickup, seleccionando Open > Subsystem > Search > acar_concept > 

pickup_truck_Brake_System.sub. Una vez abierto guardamos una copia idéntica en 

nuestra base de datos, asignándole el nombre de “Jeep_WMB_Brake_System”. 

Posteriormente, deberemos modificar las propiedades del sistema de frenos, abrimos 

nuestro subsistema con un editor de texto y modificamos las variables necesarias para 

adecuar el comportamiento del freno. En este caso no tenemos los datos reales, pero 

sabemos que un coche normal frena de 80 Km/h a 0 Km/h en 70 metros 

aproximadamente. Por lo que para nuestro automóvil que tiene tracción integral 

supondremos una frenada en alrededor de 100 metros. Para conseguir este resultado 

de parte de la configuración de los frenos, habrá que realizar un proceso de prueba y 

error en conjunto con la simulación de frenado, esto una vez terminado el modelado del 

resto del vehículo en Adams Car.  
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De esta manera, cambiando variables como los radios del pistón, las áreas y el 

coeficiente de rozamiento del freno, obtuvimos que los valores de las propiedades del 

freno deberán quedar como se muestra a continuación. 

 

 

Figura 76: [5-61] Fichero de parámetros del subsistema de los frenos 

 

 

Figura 77: [5-62] Subsistema de los frenos terminado 
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6. Ensamblado de las partes del vehículo 
6.1. Introducción al ensamblado 

 

Para poder analizar el comportamiento de nuestras suspensiones y la de nuestro 

vehículo, es necesario agrupar los subsistemas en un ensamblaje (assembly). De esta 

manera, una vez hemos terminado de crear todos los subsistemas necesarios para 

nuestro automóvil, proseguimos creando los ensamblajes. En principio habría que 

crear tres: El ensamblaje de la suspensión delantera, el de la suspensión trasera y por 

último el del vehículo completo. Pero dado que, por la naturaleza de nuestro palier 

(driveline) y del subsistema de la suspensión trasera, ya que, esta no puede existir sin 

el palier y el palier sin la suspensión delantera, debido a las conexiones que llevan, no 

podemos analizar por separado el ensamblaje de la suspensión trasera.  

 

 

6.2. Ensamblado de la suspensión delantera 
El ensamblaje de la suspensión delantera se compone en general de los subsistemas 

que componen la suspensión que en nuestro caso son la suspensión delantera y las 

ballestas delanteras y a estos se les añade la dirección.  

Para hacerlo, en el modo Standart de Adams Car, seleccionamos File > New > Suspension 

Assembly. Nos aparecerá una pestañe como la que se muestra a continuación donde 

introduciremos los subsistemas correspondientes. 

 

 

Figura 78: [6-1] Creación del ensamblado de la suspensión delantera 
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Una vez rellenadas las casillas presionamos el botón de “OK” y se generará el 

ensamblado en pantalla tal y como se muestra a continuación. 

 

 

Figura 79: [6-2] Ensamblado de la suspensión delantera 

 

Finalmente guardamos el ensamblaje de la suspensión delantera en nuestra base de 

datos mediante File > Save As > Assembly, como 

“Jeep_WMB_Front_Suspension_Assembly”. 
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6.3. Ensamblado del vehículo completo 
Por último, realizamos el ensamblado del vehículo completo agrupando todos los 

subsistemas que hemos creado hasta el momento. 

Para ello seleccionamos File > New > Full-Vehicle Assembly. Y en la ventana que se 

muestra a continuación añadimos en su lugar respectivo los subsistemas indicados.  

 

 

Figura 80: [6-3] Creación del ensamblado del vehículo completo 

 

Una vez rellenados lo espacios como corresponde, presionamos el botón de “OK” y se 

generará el ensamblado en pantalla tal y como se muestra a continuación. 
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Figura 81: [6-4] Ensamblado del vehículo completo 

 

Finalmente comentar que hemos procedido modificando cada subsistema con el 

objetivo de que cada uno se posicione en su lugar correspondiente, pero existe la 

posibilidad de que una vez ensamblado el vehículo se acomoden o ajusten las 

posiciones de los subsistemas de modo que todo se situé en su sitio indicado. 
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7. Simulación dinámica del vehículo 
7.1. Introducción a la simulación dinámica 

 

A continuación, haremos uso de la herramienta de simulación dinámica que ofrece 

Adams Car, para la cual hemos realizado todos los anteriores pasos. Teniendo creados 

los ensamblados que necesitamos, gracias a esta herramienta, podremos analizar 

gráficamente e incluso visualmente atreves de una animación, el comportamiento 

dinámico del ensamblado en cuestión.  

Está simulación del vehículo si bien pretende comunicar al ingeniero el 

comportamiento real que tendría un automóvil bajo estas condiciones de diseño; al 

haber aproximado las propiedades y características de este, consecuentemente lo que 

obtendremos será un comportamiento aproximado a la realidad y no el 

comportamiento real del vehículo. No obstante, hemos realizado este proyecto de 

manera que los resultados que vayamos a obtener sea lo más coherentes y propios del 

vehículo real que se pueda.  

Además, cabe mencionar que esta herramienta ha sido crucial en las etapas finales del 

modelado, para ajustar mediante prueba y error las propiedades de algunos 

subsistemas, como se mencionó anteriormente. 

Por lo que de ahora en adelante realizaremos pruebas al ensamblado de la suspensión 

delantera y a la del vehículo completo para luego analizarlas. No realizaremos todas las 

pruebas que tiene el programa dado que, si así fuera, aunque pudiera ser interesante, 

alargaríamos innecesariamente el trabajo. Trabajo que, con las pruebas principales que 

contendrá, habrá cumplido su propósito final, el cual es estudiar el comportamiento 

dinámico del Willys MB/Ford GPW. 

 

 

7.2. Simulación dinámica de la suspensión delantera 
 

Para el ensamblado de la suspensión delantera nos dedicaremos a hacer tres diferentes 

simulaciones dinámicas para luego analizarlas. Estas serán el “Parallel y Opposite Wheel 

Travel” y como tercera, la simulación “Steering”. Para cada simulación sacaremos una 

gráfica con tres líneas representativas, que corresponderán a los ángulos de caída, 

convergencia y de avance. Las primeras dos tendrán un propósito más que el solo hecho 

de ser analizadas ya que se usan para ajustar los ángulos de caída y convergencia de la 

suspensión delantera, como se mencionó en dicho subsistema. 
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7.2.1. Parallel Wheel Travel  
Para la realización de esta simulación dinámica, seleccionaremos, en el modo “Standart 

Interface”, Simulate > Suspension Analysis > Parallel Wheel Travel. Tras dicha secuencia 

de selecciones aparecerá una ventana que deberá ser rellenada de la siguiente manera. 

 

 

Figura 82: [7-1] Parámetros del análisis Parallel Wheel Travel 

 

Una vez presionado “OK” en la ventana del análisis se realizará la simulación y una vez 

acabada de manera exitosa, haremos uso de la herramienta de Post-procesador de 

Adams Car. El “Postprocessor” de Adams Car nos permitirá revisar y analizar en graficas 

el comportamiento o resultados de nuestra simulación.  

Para abrir el “PostProcessor” habremos de realizar la siguiente operación Review > 

PostProcessing Window. Una vez abierta la ventana, seleccionaremos el nombre de 

nuestra simulación en la casilla de Simulation y mediante el resto de casillas 

seleccionando la gráfica que se desee ver obtendremos una gráfica como la que tenemos 

a continuación. 
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Figura 83: [7-2] Resultados del análisis Parallel Wheel Travel 

 

La grafica anterior, muestra tres ángulos de la rueda izquierdad que 

correspondientemente, traducidas, se refieren a: “Camber Angle” = Ángulo de Caída, 

“Caster Angle” = Ángulo de Avance, “Toe Angle” = Ángulo de Convergencia. 

Dado que no conocemos los ángulos característicos de nuestro modelo real, hemos 

investigado acerca del rango de valores que cada ángulo debería tener en el caso de un 

vehículo estándar.  

  

Angulo de caída: 

 

Figura 84: [7-3] Angulo de caída (Ref. 19) 

 

En cuanto a el ángulo de caída o “camber”, es el que forma el eje de simetría del 

neumático con la vertical que corta en el punto de contacto entre el neumático y el suelo. 

Este ángulo se ajusta de forma que, al tomar una curva, la rueda interior (que es la que 

soporta la mayor parte de los esfuerzos) trabaje perpendicular al suelo, consiguiendo 
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así un menor desgaste en los neumáticos y fatiga en los diversos elementos de la 

suspensión y la dirección. 

El valor típico del ángulo de caída suele estar comprendido entre 0° y -2° (de forma que 

las ruedas se quedan un poco abiertas o “espatarradas”).  

 

Teniendo esto en cuenta, podemos observar que, nuestro modelo ronda con un ángulo 

de caída muy próximo a 0° por el lado positivo, con lo cual está dentro de lo que se 

podría considerar razonable y adecuado. Aunque también es cierto que, por tener una 

ligera tendencia hacia el lado positivo, en otras palabras, a estar más cerrado que 

abierto en la vertical, las rueda podrían presentar cierto desgaste. 

 

Ángulo de avance: 

 

Figura 85: [7-4] Ángulos Dirección Coche Alineado Angulo Avance (Ref. 19) 

 

El ángulo de avance o “caster” es el ángulo formado por el pivote con el eje vertical que 

pasa por el centro de la rueda, viendo el coche desde el lateral, y en el sentido de la 

marcha. Tiene un valor entre 0° y 3° para los vehículos de tracción delantera, y entre 5° 

y 10° para tracciones trasera. 

Entre las principales funciones del ángulo de avance se encuentran las de conseguir una 

dirección estable y precisa, con un buen auto centrado y reversibilidad, evitando 

además las vibraciones en las ruedas y que sean transmitidas a los diferentes elementos 

de la suspensión y la dirección. 

Este es el único ángulo que estando fuera de sus valores no produce un desgaste 

anómalo en el neumático. Como síntomas podemos destacar una reversibilidad 

excesiva o insuficiente, según al valor sea mayor o menor del indicado por el fabricante, 

así como una falta de estabilidad en la misma. 
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Dado esto, podemos concluir que nuestro modelo está dentro de lo razonable, teniendo 

en cuanta que contamos con un vehículo de tracción total y que los ángulos pueden 

variar entre 0° y 10° aproximadamente y con que nuestro ángulo de avance se 

encuentra entre los valores de 4.5° y 8°. 

 

Ángulo de convergencia: 

 

Figura 86: [7-5] Ángulos de convergencia (Ref. 19) 

 

El ángulo de convergencia o “toe” es el ángulo, visto desde arriba, que forman las ruedas 

con el eje longitudinal del vehículo en el sentido de la marcha. Además, es el único 

ángulo de la dirección que también puede expresarse en milímetros, ateniéndonos a du 

definición como “la diferencia de distancia entre las partes trasera y delantera de la 

llanta a la altura de la mangueta”. Así, una convergencia es positiva cuando las ruedas 

están cerradas en su parte delantera, y negativa o divergente cuando están abiertas. 

El ángulo de convergencia depende de los valores de los demás ángulos de la dirección, 

así como del tipo de tracción del vehículo. Por un lado, debido al ángulo de caída y salida, 

la rueda está inclinada respecto del terreno, de forma que al girar lo hace sobre la 

generatriz de un cono imaginario, por lo que tiende abrirse. Por tanto, se requiere de 

una convergencia positiva. Sin embargo, en los ejes tractores las ruedas tienden a 

cerrarse, por lo que la convergencia será negativa. 

Ahora teniendo en cuenta que las cuatro ruedas de nuestro vehículo son tractoras, es 

razonable tener un resultado de ángulo divergente óseo negativo, con un valor de entre 

-0.5° y -2.5° aproximadamente. 

 

Con esto podemos concluir que los ángulos de nuestro modelo están dentro de lo que 

se considera razonable y de acuerdo con un vehículo estándar. 
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7.2.2. Opposite Travel Front 
El analisis de simulacion “Opposite Wheel Travel” es muy similar al analisis del “Parallel 

Wheel Travel”. La diferencia radica en que en el analisis del “Opposite Wheel Travel”, 

en ves de acelerar o frenar en linea recta como en el “Parallel Wheel Travel” se trata de 

la misma prueba pero de entrada en curva. Lo cual da como resultado que una de las 

ruedas se hunda y la otra se estire.  

Para relalizar este analisis habrá que seleccionar Simulate > Suspension Analysis > 

Opposite Wheel Travel. Y rellenaremos la pestaña como se muestra a continuación. 

 

 

Figura 87: [7-5] Parámetros del análisis Opposite Wheel Travel 

 

De la misma manera que operamos en el apartado anterior, abriremos las gráficas que 

queremos analizar. Seleccionando Review > PostProcessing Window, y eligiendo en la 

pestaña la simulación que deseamos analizar.  
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Figura 88: [7-7] Resultados del análisis Opposite Wheel Travel 

 

Observando esta gráfica y la anterior observamos que sus comportamientos son 

distintos en cierto grado, particularmente para la curva del ángulo de caída, lo cual se 

debe a que estamos tratando con una suspensión dependiente conectada a través de un 

eje y se trata de un comportamiento normal.  
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7.2.3. Steering 
El tercero de los análisis necesarios para estudiar el comportamiento de este 

ensamblado es el de la dirección. Gracias a este análisis, se puede comprobar el 

comportamiento del giro de las ruedas. De esta manera, seleccionamos Simulate > 

Suspension Anlysis > Steering, y a continuación rellenamos la ventana como se muestra 

en la siguiente figura. 

 

 

Figura 89: [7-8] Parámetros del análisis Steering 

 

Y tal como lo hicimos anteriormente revelamos las grafica que se muestra a 

continuación. 
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Figura 90: [7-9] Resultados del análisis Steering 

 

Observamos que los ángulos de caída “camber” y el de avance “caster” se mantienen 

aproximadamente igual que los correspondientes del análisis del “Parallel Wheel 

Travel”. Mientras que el ángulo de convergencia “toe” sufre una visible variación. 

Observamos que a medida que se realiza el giro el ángulo va pasando, de forma casi 

lineal, de un valor positiva a un valor negativo.  

 

 

7.3. Simulación dinámica del vehículo completo 
Llegados a este punto, de la misma manera que hemos realizado para el anterior 

ensamblado, realizaremos un análisis de las principales simulaciones del ensamblado 

del vehículo completo. Lo cual nos permitirá conocer de manera global el 

comportamiento dinámico del vehículo que hemos venido construyendo, como 

también optimizar y ajustar las propiedades y geometrías del modelo para finalmente 

obtener un modelo lo más aproximado a la realidad.  

Para ello, abriremos el ensamblado que hemos creado con anterioridad, seleccionando 

en el modo “Standart” File > Open > Assembly > Search > Private > 

Jeep_WMB_Full_Vehicule_Assembly.asy, 

 

7.3.1. Acceleration 
La prueba de aceleración es el primer análisis que le haremos a nuestro vehículo, y 

también es la primera prueba con la que podemos verificar si nuestro ensamblaje 

funciona. Es la prueba con la que hemos trabajado la mayor parte del proceso de ajuste 

y de prueba y error de nuestro modelo.  
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Para realizar el análisis, seleccionaremos Simulate > Full Vehicle Analysis >Straight-Line 

Events > Acceleration. Y en la ventana que se muestra a continuación introducimos las 

siguientes condiciones.  

 

 

Figura 91: [7-10] Parámetros del análisis Acceleration 

 

Una vez realizado el análisis, y verificado que la prueba de aceleración no presenta 

ningún problema, precederemos a analizar los resultados y comprar las similitudes que 

se tiene respecte al modelo real. 

Con este propósito, seleccionamos Review > PostProcessing Window y obtendremos las 

gráficas que nos interesan.   

 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

93 

 

Figura 92: [7-11] Simulación Acceleration - Gráfica del desplazamiento del vehículo 

 

Como podemos observar la gráfica de velocidad indica que nuestro modelo alcanza los 

93 Km/h en 15 segundos. Este resultado se podría considerar exitoso ya que en la 

realidad el modelo real alcanza los 97Km/h en 15 segundos, lo cual es bastante cercano 

a lo que nos presenta la gráfica. 

 

 

 

Figura 93: [7-12]  Simulación Acceleration - Gráfica de la velocidad del vehículo 

 

En el caso de la distancia recorrida podemos observar que nuestro vehículo recorre 

alrededor de 215 metros en 15 segundos. Lo cual, si lo comparamos con la realidad, 
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vemos que estamos bastante aproximados. Ya que, haciendo algunos cálculos con los 

datos reales mencionados anteriormente de la velocidad (cálculos de movimiento 

cinemática), vemos que el vehículo debería recorrer aproximadamente 203 metros en 

15 segundos. Lo cual se podría considerar un éxito, teniendo en cuenta un error por 

debajo del 6 %.  

 

 

Figura 94: [7-13]  Simulación Acceleration - Gráfica del cambio de marchas del vehículo 

 

 

Figura 95: [7-14]  Simulación Acceleration - Gráfica de las revoluciones por minuto del vehículo 

 

De las gráficas anteriores podemos observar el comportamiento del motor y el de la 

caja de cambios del modelo. Como se puede ver, a medida que aumente la aceleración 

el motor aumenta de marcha hasta llegar a la máxima marcha que es la tercera. También 
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podemos observar como las revoluciones suben en el trascurso de cada marcha y al 

realizar el cambio de marcha esta presenta una bajada que corresponde con la 

operación que realiza el embrague en el cambio. 

 

 

7.3.2. Braking 
Otro de los análisis más importantes y útiles que ofrece Adams Car es el de frenado. 

Realizando esta operación obtenemos resultados de cómo se comporta el vehículo a la 

hora de frenar. Para realizar este análisis seleccionamos Simulate > Full Vehicle Analysis 

> Straight-Line Events > Braking… Y rellenamos la ventana que aparece como se 

muestra a continuación.  

 

 

Figura 96: [7-15] Parámetros del análisis Braking 

 

Para poder observar su comportamiento, como hicimos previamente abrimos el 

PostProcessor y revelamos las gráficas que deseamos analizar.  
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Figura 97: [7-16] Simulación Braking - Gráfica de la velocidad del vehículo 

 

 

Figura 98: [7-17] Simulación Braking - Gráfica del desplazamiento del vehículo 

 

Como se puede observar en las gráficas, el vehículo pasa de 80 Km/h a 0 Km/h en 

alrededor de 7.5 segundos y recorriendo 100 metros. Este valor como dijimos 

previamente en el modelado del subsistema del sistema de freno, es un valor 

aproximado ya que no contamos con los datos reales. No obstante, hemos supuesto este 

mismo valor teniendo en cuenta que un vehículo normal pasa de 80 Km/h a 0 Km/h 

recorriendo 70 metros. Y le atribuimos a nuestro modelo un aproximado de 100 metros 

de recorrido, ya que, lleva una tracción integral, que, dificulta el frenado debido a entre 

otras cosas al peso. Y además se lo atribuimos a la tecnología de frenado que se tenía en 

ese entonces. Pareciéndonos un valor razonable. 
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Figura 99: [7-18] Simulación Braking - Gráfica del par de frenado  del vehículo 

 

En la gráfica en cuestión, podemos observar el par de frenado de las 4 ruedas. Vemos 

como ruedas de un mismo eje llevan el mismo par. Y también la diferencia de par entra 

las delanteras y traseras. Esto se debe a que la presión relativa de frenado del eje 

delantero es mayor al trasero, en nuestro, es debido a que el “Brake bias” del delantero 

es del 60% y por ende el del trasero es del 40%. Variable que indica la presión de 

frenado. 

 

 

7.3.3. Brake in Turn 
La siguiente simulación, es un estudio de frenado en curva que pretende analizar el 

comportamiento del vehículo mientras desacelera realizando un giro de curva 

constante. Para realizar esta simulación habrá que seleccionar Simulacion > Ful-

Vehicule análisis > Conering Events > Brake in Turn. Una vez abierta la pestaña podemos 

controlar varios parámetros como el radio de giro, la aceleración lateral o la 

desaceleración. Para nuestro vehículo configuraremos la tabla de la siguiente manera. 
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Figura 100: [7-19] Parámetros del análisis Braking in Turn 

 

A continuación, abrimos el Post-Procesador, y analizamos los resultados.  

 

 

Figura 101: [7-20] Simulación Braking in Turn - Gráfica de la velocidad del vehículo 
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Figura 102: [7-21] Simulación Braking in Turn - Gráfica del cambio de marchas del vehículo 

 

Con la primera de las gráficas anteriores, observamos cómo, de manera gradual, 

desacelera el vehículo a medida que se le impone una frenada de 0.1g, con pequeñas 

variaciones justo en los momentos de cambio de marcha. Y gracias a la segunda gráfica, 

vemos cómo cambia de marchas, disminuyendo a medida que frenaba y vemos también 

cómo se distribuyen las marchas según el vehículo se obligaba a bajar las revoluciones.  

 

 

7.3.4. Constant Radius Cornering 
A continuación, la simulación de giro en curva de radio constante, como su nombre 

indica, nos permite analizar el comportamiento del vehículo cuando se le impone girar 

en una curva de radio constante. La cual es usada en la industria para determinar el 

limite condicional a partir del cual el vehículo vuelca. Permitiéndonos variar 

parámetros como velocidades iniciales y finales, radio de giro y duración de la 

maniobra.   

Para realizar esta simulación seleccionaremos Simulate > Full-Vehicule Analysis > 

Cornering Events > Constant Radius Cornering, y a continuación rellenamos la ventana 

como se muestra en la siguiente imagen. 
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Figura 103: [7-22] Parámetros del análisis Constant Radius Cornering 

 

Y como hicimos anteriormente abrimos el Post-Procesador.  
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Figura 104: [7-23] Simulación Constant Radius Cornering - Gráfica de las velocidades del vehículo 

 

 

Figura 105: [7-24] Simulación Constant Radius Cornering - Gráfica del desplazamiento del vehículo 

 

Como podemos observar, en la primera gráfica, la velocidad aumenta de manera lineal 

y sin pequeños picos a mediada que el vehículo avanza en la curva. La ausencia de picos 

representa que el vehículo no ha cambiado de marcha en toda su trayectoria. Por otro 

lado, vemos que en la segunda grafica como el ángulo del vehículo con respecto del 

camino va en aumento de manera casi lineal, en ángulos negativos, un aumento de no 

menos de dos grados en todo su trayecto. Aumento que además se pretenderá evitar ya 

que si este aumenta en exceso sucederá el vuelco que intentamos prevenir.  
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Figura 106: [7-25] Simulación Constant Radius Cornering - Gráfica de la aceleración lateral del vehículo 

 

 

Figura 107: [7-26] Simulación Constant Radius Cornering - Gráfica de las velocidades laterales del vehículo 

 

Finalmente, también será interesante analizar cómo comportamiento lateral del 

vehículo. Vemos gracias a la primara gráfica como este acelera de manera lineal a lo 

largo del trayecto. Y gracias a la segunda vemos como aumenta de velocidad de manera 

ligeramente exponencial debido a que no sufre un aumente exagerado de aceleración. 

Y sin pequeños picos en ambos casos ya que no ocurre ningún cambio de marcha.  
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7.3.5. Double Lane Change 
Finalmente, la siguiente simulación “Double Lane Change” simula la situación en que el 

vehículo cambia de carril y vuelve al mismo, como si se tratase de un adelantamiento o 

de esquivar un obstáculo en la carretera. De manera análoga al anterior este análisis 

trata de encontrar el limite a partir de cual el vehículo no es capaz de realizar tal hazaña. 

Par esta simulación nos pondremos en la situación en que el vehículo transcurre a una 

velocidad de 40 Km/h. Para tal caso habremos de seleccionar Simulate > Full-Vehicule 

Analysis > Double Lane Change, y rellenaremos la ventana como se muestra a 

continuación.  

 

 

Figura 108: [7-27] Parámetros del análisis Double Lane Change 

 

Tras esto, abrimos el Post-Procesador.  
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Figura 109: [7-28] Simulación Double Lane Change - Gráfica de la velocidad del vehículo 

 

 

Figura 110: [7-29] Simulación Double Lane Change - Gráfica del desplazamiento lateral del vehículo 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

105 

 

Figura 111: [7-30] Simulación Double Lane Change - Gráfica de la aceleración lateral del vehículo 

 

 

Figura 112: [7-31] Simulación Double Lane Change - Gráfica del giro del volante del vehículo 

 

Como observamos gracias a las diferentes graficas que se muestran, vemos que el 

vehículo se mantiene alrededor de los 40 Km/h a lo largo de la maniobra, con muy 

pequeñas variaciones. Variaciones que se concentran en un lapso de tiempo, entre el 

segundo 5 y el segundo 15, que corresponde a el momento en que el vehículo cambia 

de carril y vuelve al mismo. Vemos como al comienzo de este lapso de tiempo se 

modifica el ángulo del volante, lo cual produce una reducción de velocidad y una 

deceleración lateral, ya que comienza el giro. Y en cuanto al desplazamiento lateral, 

vemos como en el momento que se produce el lapso de tiempo el vehículo se mueve 

hasta la posición que corresponde al carril de adelanto y vuelve a su posición original. 
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8.  Conclusión del proyecto 
8.1. Análisis del proyecto 

 

A lo largo de este trabajo se ha hablado sobre la relevancia histórica y tecnológica que, 

el automóvil Willys MB/Ford GPW (Jeep) tiene sobre la industria automovilística. 

Particularmente, cuando se trata de todoterrenos de uso civil. Siendo este el precursor 

de la gran mayoría de los que existen hoy en día. También hemos podido apreciar la 

gran utilidad y el basto potencial de las herramientas informáticas de análisis dinámico. 

Una herramienta que, si bien trae detrás una significativa leyenda de pruebas y errores, 

ensayos fallidos, experiencia, estudios avanzados y una gran cantidad de esfuerzo, ha 

alcanzado a lo que hoy se podría considerar como una de las herramientas más 

valoradas del campo de la ingeniería mecánica.   

Como se ha expuesto con anterioridad el análisis del comportamiento dinámico de un 

automóvil nos permite predecir cómo responderá o reaccionará el vehículo a 

denominadas situaciones controladas bajo parámetros condicionados. Lo cual a su vez 

nos permite optimar el vehículo para que se comporte de la manera deseada con la 

mayor eficacia y eficiencia posibles. De manera que, nos pareció interesante poder 

poner a prueba la precisión con que esta herramienta podía simular el comportamiento 

de un vehículo de semejante trayectoria histórica. Para este propósito, ya que los 

mecanismos utilizados en este vehículo no son propiamente los más usuales en los 

automóviles que existen al momento, fue un reto el modificar y ajustar los subsistemas 

existentes de la base de datos del programa y ensamblarlos, de manera que el modelo 

trabajado se aproxime lo mejor posible al real.  

Aunque quizá habría sido interesante profundizar más en subsistemas particulares del 

Willys MB/Ford GPW como son las suspensiones de ballesta y el palier de transmisión 

integral, como por ejemplo habría sido poder modificar las propiedades elásticas y de 

rigidez de las ballestas o las relaciones de transmisión de potencia del palier; a pesar de 

no habernos adentrado tanto en estas propiedades, por falta de conocimiento del 

funcionamiento del programa, hemos adquirido bastante conocimiento que nos serán 

muy útiles en futuros trabajos.  

Finalmente hemos logrado crear un modelo razonablemente optimo capaz de superar 

las pruebas principales de simulación dinámica, acercándonos bastante al 

comportamiento del vehículo real. Además, hemos podido conocer la historia de un 

vehículo histórico de trascendencia internacional y conocer sus ventajas y desventajas 

teniendo en cuenta como este está fabricado.  
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8.2. Futuros trabajos 
 

Teniendo el modelo realizado, sería de mucho interés optimizarlo y profundizar sobre 

los aspectos anteriormente mencionados. Mejorar y ajustar los parámetros 

característicos de los subsistemas de la suspensión de ballesta y el palier de transmisión 

integral. De manera que se pueda conseguir un vehículo mucho más cercano al original. 

Sobre todo, poder ajustar la rigidez de las ballestas para poder representar la 

característica particular, y tal vez más importante, del vehículo que sería la de ser 

utilizado en terrenos rugosos y poco amigables.  

Sería interesante también trabajar sobre las falencias del modelo real del vehículo, 

como son las vibraciones, el frenado o su manejabilidad. Y así analizar la posibilidad de 

optimizar el famoso Jeep Willys MB. 

 

 

8.3. Opinión personal 
 

Además, este trabajo fin de grado, de modelizar el Willys MB/Ford GPW nos ha 

permitido profundizar en nuestro conocimiento sobre el manejo en programas como 

Solid Works y Adams Cars. Que, en lo personal, debido a que el diseño mecánico es una 

de mis ramas favoritas de la ingeniería, estos conocimientos me serán de gran ayuda en 

el futuro. También, este proyecto ha sido un método excelente para conocer 

profundamente un vehículo, su comportamiento y su funcionamiento. Conocimientos 

que me hizo mucha ilusión poder adquirir desde antes de empezar la carrera. A todo 

esto, sumarle que se ha trabajado estos conocimientos sobre un vehículo histórico, hace 

que sea una gran satisfacción poder acabar este proyecto. Aunque a mi parecer ha 

tomado mucho más tiempo del que debía, debido a la situación actual, he disfrutado 

cada parte del trabajo.  
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9. Pliego de condiciones 
 

Dado que, la naturaleza de este proyecto está centrado en análisis y en trabajo realizado 

mediante métodos informáticos, no existen leyes aplicables que limiten o condicionen 

de manera significativa este trabajo. No existen condiciones técnicas o ambientales a 

las que ceñirse. No obstante, si hay una serie de parámetros y recomendaciones que se 

deberán cumplir de modo que se obtenga un comportamiento dinámico, del vehículo 

en cuestión, lo más aproximado al modelo real del mismo. 

De modo que, para realizar este trabajo de fin de grado, que consiste en el modelado y 

simulación dinámica del Willys MB/Ford GPW (Jeep), se establecen una serie de 

condiciones.  

 En primer lugar, necesitaremos una laptop u ordenador de sobre mesa, que 

cumpla con los requisitos mínimos de software y hardware. Como, por ejemplo, 

la que se ha utilizado para la realización de este como es una Asus i7 -670HQ de 

procesador Intel, con tarjeta gráfica NVIDIA GTX 950M, 16 GB de memoria RAM 

y 1 TB de disco duro para realizar el proyecto.  

 Se necesitará poseer una licencia del paquete Microsoft Office Professional del 

año en cuestión, en nuestro caso 2016, para realizar la redacción de la memoria 

y para ciertos cálculos con ayuda de Excel como son por ejemplo las curvas 

motor del vehículo o las inercias y los pesos.  

 Además, para el diseño del vehículo necesitaremos obtener una licencia del 

software SolidWorks 2019.  

 También será necesaria la licencia del programa MSC Adams Car versión 2019.2 

para realizar el modelaje, ensamblado y análisis dinámico del vehículo.  

 

 Finalmente, de manera general necesitamos contar, con las medidas 

geométricas y propiedades de los subsistemas del vehículo que nos permitan un 

funcionamiento aproximado al original, con las curvas del aproximadas del 

motor y con las relaciones de transmisión del mismo. Y por último asegurarse 

de que las características de frenado y aceleración estén lo más próximas a las 

reales del vehículo. 
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10. Presupuesto 
Para poder abordar de manera óptima el presupuesto de este trabajo, cabe mencionar 

que, debido a ciertas circunstancias en las que se ha realizado el proyecto, este, se ha 

alargado más de lo necesario. Debido a la situación sanitaria que atravesamos hoy en 

día y a la deficiencia de conexión existente debido a ella es que las horas del trabajo se 

han inflado a lo que serían normalmente. Y dado que, las horas de trabajo son la 

magnitud representativa para sacar el coste del proyecto, es que se da como resultado 

el siguiente presupuesto. 

 

Horas del personal  

Concepto Cantidad 
en horas 

Precio Parcial 

Ingeniero Mecánico 370 10,00 € 3.700,00 € 
Director del Proyecto 48 17,00 € 816,00 € 

  Total 4.516,00 € 
 

Software informático 

Concepto Cantidad 
en horas 

 Precio 

Microsoft Office Proffesional 2016 70  135,00 € 
SolidWorks 2018 5  90,00 € 

MSC Adams Car 2019 295  2.065,00 € 
  Total 2.290,00 € 

 

Material del proyecto 

Concepto Cantidad 
en horas 

 Precio 

PC Asus i7 -670HQ 370  1.110,00 € 
Material de oficina   30,00 € 

  Total 1.140,00 € 
 

 

 

 

 

El coste total del proyecto es de nueve mil seiscientos catorce con sesenta y seis 

céntimos 

Coste Total 7.946,00 € 
IVA 1.668,66 € 

Coste Total del Proyecto 9.614,66 € 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

112 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

113 

11. Bibliografía 
 

11.1. Bibliografía 

  
Ingeniería del automóvil: sistemas y comportamiento dinámico. Luque, Pablo | Vera, 

Carlos; Álvarez, Daniel | Madrid: International Thomson, cop. 2004. 

Modelado y simulación dinámica del automóvil Citroën 2CV. Guzmán Carsí, Xavier | 

Suñer Martinez, Josep Lluis; Universitat Politècnica de València. Escuela Técnica Superior 

de Ingeniería del Diseño. 

Modelado y simulación dinámica del automóvil Volkswagen Tipo 1 (Escarabajo). Sáiz 

Oviedo, Roque | Suñer Martinez, Jose-Luis; Universitat Politècnica de València. 

Departamento de Ingeniería Mecánica y de Materiales. 

Modelado y simulación dinámica del automóvil Fiat/Seat 600. Sevilla Lacruz, Víctor | 

Suñer Martinez, Josep Lluis; Universitat Politècnica de València. Escuela Técnica Superior 

de Ingeniería del Diseño 

https://grabcad.com/library/willys-jeep-5 [Recuperado el 5 de Mayo de 2020]. 

https://es.slideshare.net/blancaisabelcig/ord-9-snl-g503-1-parte-ford-gpw-willys-
mb-octubre-1949-planos-en-espaol-e-ingls  [Recuperado el 21 de junio de 2020]. 

https://es.wikipedia.org/wiki/Willys_MB [Recuperado el 15 de junio de 2020]. 

https://www.topgear.es/noticias/garaje/evolucion-jeep-willys-wrangler-175116  
[Recuperado el 15 de junio de 2020]. 

https://www.dday-overlord.com/es/equipo/vehiculos/jeep-willys [Recuperado el 20 
de junio de 2020]. 

http://www.almuro.net/sitios/Mecanica/suspension.asp?sw12=1 [Recuperado el 7 de 
julio de 2020]. 

https://ingemecanica.com/tutorialsemanal/tutorialn73.html [Recuperado el 7 de julio 
de 2020]. 

https://www.ro-des.com/mecanica/sistema-de-direccion-que-es/ [Recuperado el 14 
de julio de 2020]. 

http://www.autogallery.org.ru/willysmb.htm [Recuperado el 14 de julio de 2020]. 

https://www.kaiserwillys.com/tech-guide/l4-134-engine-specs [Recuperado el 20 de 
julio de 2020]. 

https://www.automobile-
catalog.com/curve/1945/1306565/willys_universal_jeep_cj-2a.html [Recuperado el 3 
de octubre de 2020]. 

https://grabcad.com/library/willys-jeep-5
https://es.slideshare.net/blancaisabelcig/ord-9-snl-g503-1-parte-ford-gpw-willys-mb-octubre-1949-planos-en-espaol-e-ingls
https://es.slideshare.net/blancaisabelcig/ord-9-snl-g503-1-parte-ford-gpw-willys-mb-octubre-1949-planos-en-espaol-e-ingls
https://es.wikipedia.org/wiki/Willys_MB
https://www.topgear.es/noticias/garaje/evolucion-jeep-willys-wrangler-175116
https://www.dday-overlord.com/es/equipo/vehiculos/jeep-willys
http://www.almuro.net/sitios/Mecanica/suspension.asp?sw12=1
https://ingemecanica.com/tutorialsemanal/tutorialn73.html
https://www.ro-des.com/mecanica/sistema-de-direccion-que-es/
http://www.autogallery.org.ru/willysmb.htm
https://www.kaiserwillys.com/tech-guide/l4-134-engine-specs
https://www.automobile-catalog.com/curve/1945/1306565/willys_universal_jeep_cj-2a.html
https://www.automobile-catalog.com/curve/1945/1306565/willys_universal_jeep_cj-2a.html


Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

114 

https://diccionario.motorgiga.com/diccionario/ballesta-definicion-significado/gmx-
niv15-con193084.htm [Recuperado el 15 de agosto de 2020]. 

https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-
coche/#convergencia[Recuperado el 10 de agosto de 2020]. 

 

 

11.2.  Referencias 
 

[1] https://es.wikipedia.org/wiki/American_Bantam_Company Imagen del prototipo 
todoterreno desarrollado por Bantman, precursor del actual Jeep. [Recuperado el 20 de 
octubre de 2020]. 

[2] https://www.brandstocker.com/jeep-y-el-origen-de-los-4x4/ Primeros prototipos 
de la competencia para fabricar el todoterreno, donde se muestran el Willys Quad, el 
Ford Pygmy y el Bantam BRC 60 y su posterior evolución de los prototipos. Nombrados 
el Bantam BRC 40, el Ford GP y el Willys MA. [Recuperado el 20 de octubre de 2020]. 

[3] https://unosetentaydos.mforos.com/1631424/12937136-bantam-brc-40-italeri-
1-72/  Prototipos de la competencia del todo terreno juntos, al finalizar la misma. 
[Recuperado el 20 de octubre de 2020]. 

[4] https://www.tecnologia-
automovil.com/cajon_de_sastre/uploads/2013/02/h51caratula_imagen1.jpg?_gl=1*g
gjj62*_ga*MjgwODcwNTU1LjE1OTcwNzY5OTU Modelo hibrido adoptado de los tres 
coches al finalizar la competencia. [Recuperado el 20 de octubre de 2020]. 

[5] https://www.brandstocker.com/jeep-y-el-origen-de-los-4x4/ Donde también se 
muestra el resultado de la competencia, el Willys MB que hereda las entradas del 
Bantam y el capó del Ford. [Recuperado el 20 de octubre de 2020]. 

[6] https://www.lasegundaguerra.com/viewtopic.php?t=497 Variaciones que se le 
hicieron al Jeep durante la guerra. [Recuperado el 20 de octubre de 2020]. 

[7] http://www.elcajondegrisom.com/2012/11/gaz-67-el-jeep-sovietico.html Versión 
anfibia del Willys MB de parte de los sovietico, el GAZ-011 y una recreación histórica 
del mismo. [Recuperado el 20 de octubre de 2020]. 

[8] https://en.wikipedia.org/wiki/Willys_M38 Willys MC/M38 y más adelante una 
imagen de la compracion entre el Willys M38 y el Willys MB. [Recuperado el 20 de 
octubre de 2020]. 

[9] https://www.4x4brasil.com.br/forum/jeep-willys/133745-iniciante-com-jeep-
willys.html Variaciones del Willys MB todoterreno para uso comercial y civil. 
[Recuperado el 20 de octubre de 2020]. 

[10] https://www.pinterest.es/pin/680254718693594471/ Jeep Willys CJ5 del 1963. 
[Recuperado el 20 de octubre de 2020]. 

https://diccionario.motorgiga.com/diccionario/ballesta-definicion-significado/gmx-niv15-con193084.htm
https://diccionario.motorgiga.com/diccionario/ballesta-definicion-significado/gmx-niv15-con193084.htm
https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-coche/#convergencia
https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-coche/#convergencia
https://es.wikipedia.org/wiki/American_Bantam_Company
https://www.brandstocker.com/jeep-y-el-origen-de-los-4x4/
https://unosetentaydos.mforos.com/1631424/12937136-bantam-brc-40-italeri-1-72/
https://unosetentaydos.mforos.com/1631424/12937136-bantam-brc-40-italeri-1-72/
https://www.tecnologia-automovil.com/cajon_de_sastre/uploads/2013/02/h51caratula_imagen1.jpg?_gl=1*ggjj62*_ga*MjgwODcwNTU1LjE1OTcwNzY5OTU
https://www.tecnologia-automovil.com/cajon_de_sastre/uploads/2013/02/h51caratula_imagen1.jpg?_gl=1*ggjj62*_ga*MjgwODcwNTU1LjE1OTcwNzY5OTU
https://www.tecnologia-automovil.com/cajon_de_sastre/uploads/2013/02/h51caratula_imagen1.jpg?_gl=1*ggjj62*_ga*MjgwODcwNTU1LjE1OTcwNzY5OTU
https://www.brandstocker.com/jeep-y-el-origen-de-los-4x4/
https://www.lasegundaguerra.com/viewtopic.php?t=497
http://www.elcajondegrisom.com/2012/11/gaz-67-el-jeep-sovietico.html
https://en.wikipedia.org/wiki/Willys_M38
https://www.4x4brasil.com.br/forum/jeep-willys/133745-iniciante-com-jeep-willys.html
https://www.4x4brasil.com.br/forum/jeep-willys/133745-iniciante-com-jeep-willys.html
https://www.pinterest.es/pin/680254718693594471/


Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

115 

[11] https://alfonsodg7.wordpress.com/2013/10/20/carrocerias-de-vehiculos-tipos-
y-componentes/ La estructura de un carrocería de un vehículo estándar. [Recuperado 
el 20 de octubre de 2020]. 

[12]  http://www.42fordgpw.com/engine-go-devil-l-134/ Motor del Willys MB, el Go 
Devil L-134. [Recuperado el 20 de octubre de 2020]. 

[13] https://ingemecanica.com/tutorialsemanal/tutorialn73.html Ejemplo de una 
suspensión de ballesta, las partes de una y su funcionamiento. [Recuperado el 5 de 
septiembre de 2020]. 

[14]  https://autosblogmexico.com/mantenimiento/para-que-sirven-los-muelles-de-
suspension-de-un-auto-ta4516 La ballesta de un Willys MB.  [Recuperado el 5 de 
septiembre de 2020]. 

[15] http://mecanicautomotores.blogspot.com/2013/01/direccion-mecanica-por-
bolas.html Sistema de dirección a base de bolas circulantes. [Recuperado el 25 de 
septiembre de 2020]. 

[16] https://es.wikipedia.org/wiki/Tracci%C3%B3n_en_las_cuatro_ruedas Modelo de 
tracción integral. [Recuperado el 20 de octubre de 2020]. 

[17] https://www.championautoparts.es/news/when-to-replace-brake-pads-
discs.html Freno de disco. [Recuperado el 18 de septiembre de 2020]. 

[18] https://automecanico.com/auto2036/rearb3.html Freno de tambor. [Recuperado 
el 18 de septiembre de 2020]. 

[19] https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-
coche/ Ángulos de caída, convergencia y avance. [Recuperado el 3 de octubre de 2020]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://alfonsodg7.wordpress.com/2013/10/20/carrocerias-de-vehiculos-tipos-y-componentes/
https://alfonsodg7.wordpress.com/2013/10/20/carrocerias-de-vehiculos-tipos-y-componentes/
http://www.42fordgpw.com/engine-go-devil-l-134/
https://ingemecanica.com/tutorialsemanal/tutorialn73.html
https://autosblogmexico.com/mantenimiento/para-que-sirven-los-muelles-de-suspension-de-un-auto-ta4516
https://autosblogmexico.com/mantenimiento/para-que-sirven-los-muelles-de-suspension-de-un-auto-ta4516
http://mecanicautomotores.blogspot.com/2013/01/direccion-mecanica-por-bolas.html
http://mecanicautomotores.blogspot.com/2013/01/direccion-mecanica-por-bolas.html
https://es.wikipedia.org/wiki/Tracci%C3%B3n_en_las_cuatro_ruedas
https://www.championautoparts.es/news/when-to-replace-brake-pads-discs.html
https://www.championautoparts.es/news/when-to-replace-brake-pads-discs.html
https://automecanico.com/auto2036/rearb3.html
https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-coche/
https://www.diariomotor.com/que-es/mecanica/angulos-de-la-direccion-coche/


Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

116 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

117 

12. Anexos 
12.1. Anexo I. Características Técnicas del Vehículo 
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12.2. Anexo II. Curva característica del motor. 
 

“Horspower / Torque values for the curve above”: 

1000 rpm: 69.6 Nm / 51.3 lb-ft / 7.3 kW / 9.9 PS / 9.8 hp 

1100 rpm: 83.3 Nm / 61.4 lb-ft / 9.6 kW / 13.1 PS / 12.9 hp 

1200 rpm: 95.6 Nm / 70.5 lb-ft / 12 kW / 16.3 PS / 16.1 hp 

1300 rpm: 106.5 Nm / 78.5 lb-ft / 14.5 kW / 19.7 PS / 19.4 hp 

1400 rpm: 115.9 Nm / 85.5 lb-ft / 17 kW / 23.1 PS / 22.8 hp 

1500 rpm: 123.9 Nm / 91.4 lb-ft / 19.5 kW / 26.5 PS / 26.1 hp 

1600 rpm: 130.4 Nm / 96.2 lb-ft / 21.8 kW / 29.7 PS / 29.3 hp 

1700 rpm: 135.5 Nm / 99.9 lb-ft / 24.1 kW / 32.8 PS / 32.3 hp 

1800 rpm: 139.1 Nm / 102.6 lb-ft / 26.2 kW / 35.7 PS / 35.1 hp 

1900 rpm: 141.3 Nm / 104.2 lb-ft / 28.1 kW / 38.2 PS / 37.7 hp 

  

2000 rpm: 142 Nm / 104.7 lb-ft / 29.7 kW / 40.4 PS / 39.9 hp 

2100 rpm: 141.9 Nm / 104.6 lb-ft / 31.2 kW / 42.4 PS / 41.8 hp 

2200 rpm: 141.7 Nm / 104.5 lb-ft / 32.6 kW / 44.4 PS / 43.7 hp 

2300 rpm: 141.2 Nm / 104.1 lb-ft / 34 kW / 46.3 PS / 45.6 hp 

2400 rpm: 140.6 Nm / 103.7 lb-ft / 35.3 kW / 48.1 PS / 47.4 hp 

2500 rpm: 139.8 Nm / 103.1 lb-ft / 36.6 kW / 49.8 PS / 49 hp 

2600 rpm: 138.9 Nm / 102.4 lb-ft / 37.8 kW / 51.4 PS / 50.7 hp 

2700 rpm: 137.8 Nm / 101.6 lb-ft / 39 kW / 53 PS / 52.2 hp 

2800 rpm: 136.5 Nm / 100.7 lb-ft / 40 kW / 54.4 PS / 53.6 hp 

2900 rpm: 135 Nm / 99.6 lb-ft / 41 kW / 55.8 PS / 54.9 hp 

  

3000 rpm: 133.4 Nm / 98.4 lb-ft / 41.9 kW / 57 PS / 56.2 hp 

3100 rpm: 131.5 Nm / 97 lb-ft / 42.7 kW / 58.1 PS / 57.2 hp 
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3200 rpm: 129.6 Nm / 95.6 lb-ft / 43.4 kW / 59.1 PS / 58.2 hp 

3300 rpm: 127.4 Nm / 94 lb-ft / 44 kW / 59.9 PS / 59 hp 

3400 rpm: 125.1 Nm / 92.3 lb-ft / 44.5 kW / 60.6 PS / 59.7 hp 

3500 rpm: 122.6 Nm / 90.4 lb-ft / 44.9 kW / 61.1 PS / 60.2 hp 

3600 rpm: 119.4 Nm / 88 lb-ft / 45 kW / 61.2 PS / 60.3 hp 

3700 rpm: 116.1 Nm / 85.6 lb-ft / 45 kW / 61.2 PS / 60.3 hp 

3800 rpm: 113.1 Nm / 83.4 lb-ft / 45 kW / 61.2 PS / 60.3 hp 

3900 rpm: 110.2 Nm / 81.3 lb-ft / 45 kW / 61.2 PS / 60.3 hp 

  

4000 rpm: 107.4 Nm / 79.2 lb-ft / 45 kW / 61.2 PS / 60.3 hp 

4100 rpm: 104.4 Nm / 77 lb-ft / 44.8 kW / 61 PS / 60.1 hp 

4200 rpm: 100.7 Nm / 74.3 lb-ft / 44.3 kW / 60.2 PS / 59.4 hp 

4300 rpm: 96.3 Nm / 71 lb-ft / 43.4 kW / 59 PS / 58.1 hp 

4400 rpm: 91.4 Nm / 67.4 lb-ft / 42.1 kW / 57.3 PS / 56.4 hp 

4500 rpm: 85.9 Nm / 63.3 lb-ft / 40.5 kW / 55.1 PS / 54.2 hp 
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12.3. Anexo III. Ficheros de los subsistemas  
 

12.3.1. Carrocería 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://private/templates.tbl/_Jeep_WMB_Body.tpl' 
 MAJOR_ROLE     =  'body' 
 MINOR_ROLE     =  'any' 
 TIMESTAMP      =  '2020/10/21,20:42:09' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'aero_center_of_pressure     '  'single    '     -655.0         0.0      1249.0 
 'aero_center_of_pressure_2   '  'single    '     -155.0         0.0       349.0 
 'graphics_ref                '  'single    '     -155.0         0.0       349.0 
 'path_reference              '  'single    '     -155.0         0.0       349.0 
 'payload_cg                  '  'single    '     2345.0         0.0       949.0 
 'test_gyro                   '  'single    '   1297.643         0.0    705.0795 
 'trim_dummy                  '  'single    '   1297.643         0.0    705.0795 
 'bedplate_front_loc          '  'left/right'      755.0      -707.0       274.0 
  '(none)' 
 'bedplate_rear_loc           '  'left/right'     1805.0      -740.0       274.0 
  '(none)' 
 'f1                          '  'left/right'       15.0      -400.0       999.0 
  '(none)' 
 'f3                          '  'left/right'      845.0      -400.0       999.0 
  '(none)' 
 'f4                          '  'left/right'     1045.0      -450.0       649.0 
  '(none)' 
 'f5                          '  'left/right'     1645.0      -450.0       649.0 
  '(none)' 
 'f6                          '  'left/right'     1845.0      -450.0       799.0 
  '(none)' 
 'f7                          '  'left/right'     2345.0      -450.0       799.0 
  '(none)' 
 'f8                          '  'left/right'     2845.0      -450.0       799.0 
  '(none)' 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'chassis' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  900.0 
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 SPRUNG_PERCENTAGE        =  100.0 
 SPRUNG_LOCATION          =  'any' 
 PART_LOC_X               =  -155.0 
 PART_LOC_Y               =  0.0 
 PART_LOC_Z               =  349.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  1937.6497993757 
 CM_LOCATION_FROM_PART_Y  =  -3.4914836633 
 CM_LOCATION_FROM_PART_Z  =  420.9720257704 
 IXX                      =  2.560336E+08 
 IYY                      =  9.162028E+08 
 IZZ                      =  1.0322629E+09 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'payload' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  2.0 
 SPRUNG_PERCENTAGE        =  100.0 
 SPRUNG_LOCATION          =  'any' 
$ Part location is dependent. 
$   X,Y,Z location = 2345.0, 0.0, 949.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'trim_mass' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1297.643, 0.0, 705.0795 
 PART_ORI_ZP1             =  0.0 
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 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  0.0 
 IYY                      =  0.0 
 IZZ                      =  0.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$-------------------------------------------------------------AERODYNAMICS_FORCE 
[AERODYNAMICS_FORCE] 
 DEFINITION                    =  '.ACAR.forces.ac_aerodynamic' 
 USAGE                         =  'aero_force' 
 SYMMETRY                      =  'single' 
$ Aerodynamic force location 1 is dependent. 
$   X,Y,Z location = -655.0, 0.0, 1249.0 
$ Aerodynamic force location 2 is dependent. 
$   X,Y,Z location = 0.0, 0.0, 0.0 
 AERO_FORCE_TYPE               =  'SinglePoint2d' 
 DRAG_SCALING_FACTOR           =  1.0 
 SIDE_FORCE_1_SCALING_FACTOR   =  1.0 
 SIDE_FORCE_2_SCALING_FACTOR   =  1.0 
 LIFT_1_SCALING_FACTOR         =  1.0 
 LIFT_2_SCALING_FACTOR         =  1.0 
 ROLL_SCALING_FACTOR           =  1.0 
 PITCH_SCALING_FACTOR          =  1.0 
 YAW_SCALING_FACTOR            =  1.0 
 WIND_VELOCITY_SCALING_FACTOR  =  1.0 
 WIND_ANGLE_SCALING_FACTOR     =  1.0 
 AREA_SCALING_FACTOR           =  1.0 
 PROPERTY_FILE_LIST            =  'mdids://acar_shared/aero_forces.tbl/aerodynamic_forces_1loc.xml' 
 PROPERTY_FILE_INDEX           =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'aero_drag_active            '  'single    '   'integer'  1 
 'body_graphics_active        '  'single    '   'integer'  1 
 'outline_toggle              '  'single    '   'integer'  0 
 
 
 
 

12.3.2. Motor 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
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 TEMPLATE_NAME  =  'mdids://private/templates.tbl/_Jeep_WMB_engine_transmission.tpl' 
 MAJOR_ROLE     =  'powertrain' 
 MINOR_ROLE     =  'any' 
 TIMESTAMP      =  '2020/10/23,20:12:21' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'engine_transmission_cg      '  'single    '     593.28         0.0       549.0 
 'transmission_output         '  'single    '      883.0         0.0       549.0 
  '(none)' 
 'front_engine_mount          '  'left/right'     293.28      -300.0       349.0 
 'rear_engine_mount           '  'left/right'     893.28      -300.0       349.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'powertrain' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  73.0 
 SPRUNG_PERCENTAGE        =  100.0 
 SPRUNG_LOCATION          =  'any' 
$ Part location is dependent. 
$   X,Y,Z location = 593.28, 0.0, 549.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  10.4465209062 
 CM_LOCATION_FROM_PART_Y  =  7.376455253 
 CM_LOCATION_FROM_PART_Z  =  65.1620044824 
 IXX                      =  3.672806E+06 
 IYY                      =  4.396966E+06 
 IZZ                      =  2.849969E+06 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$--------------------------------------------------------------------SWITCH_PART 
[SWITCH_PART] 
 USAGE       =  'engine_mount_option' 
 SYMMETRY    =  'single' 
$ Switched Parts: 
$   [1] = subframe (general part) 
$   [2] = chassis (general part) 
 INDEX       =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'front_engine_mount' 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

129 

 SYMMETRY                =  'left/right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  0.0 
 ORIENTATION_ZP3         =  1.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0001.bus' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'rear_engine_mount' 
 SYMMETRY                =  'left/right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  0.0 
 ORIENTATION_ZP3         =  1.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
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 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0001.bus' 
 PROPERTY_FILE_INDEX     =  1 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'capacity_factor' 
 SYMMETRY       =  'single' 
 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  'mdids://acar_shared/torque_converters.tbl/mdi_0001.tcf' 
 CURVE_NAME     =  'CAPACITY_FACTOR' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'engine_torque' 
 SYMMETRY       =  'single' 
 TYPE           =  'three_dimensional' 
 PROPERTY_FILE  =  'mdids://private/powertrains.tbl/JeepEngineTransmission.pwr' 
 CURVE_NAME     =  'ENGINE' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'torque_ratio' 
 SYMMETRY       =  'single' 
 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  'mdids://acar_shared/torque_converters.tbl/mdi_0001.tcf' 
 CURVE_NAME     =  'TORQUE_RATIO' 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'powertrain_type             '  'single    '   'integer'  1 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'clutch_capacity             '  'single    '   'real'     1.00E+06 
 'clutch_close                '  'single    '   'real'     0.25 
 'clutch_damping              '  'single    '   'real'     10000.0 
 'clutch_open                 '  'single    '   'real'     0.75 
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 'clutch_stiffness            '  'single    '   'real'     1.00E+06 
 'clutch_tau                  '  'single    '   'real'     0.05 
 'ems_gain                    '  'single    '   'real'     0.005 
 'ems_max_throttle            '  'single    '   'real'     15.0 
 'engine_idle_speed           '  'single    '   'real'     800.0 
 'engine_inertia              '  'single    '   'real'     7.00E+05 
 'engine_rev_limit            '  'single    '   'real'     5000.0 
 'engine_stall_speed          '  'single    '   'real'     750.0 
 'gear_downshift_2            '  'single    '   'real'     1000.0 
 'gear_downshift_3            '  'single    '   'real'     1200.0 
 'gear_downshift_4            '  'single    '   'real'     1600.0 
 'gear_downshift_5            '  'single    '   'real'     2000.0 
 'gear_downshift_6            '  'single    '   'real'     2500.0 
 'gear_ratio_1                '  'single    '   'real'     2.665 
 'gear_ratio_2                '  'single    '   'real'     1.564 
 'gear_ratio_3                '  'single    '   'real'     1.0 
 'gear_ratio_4                '  'single    '   'real'     1.789 
 'gear_ratio_5                '  'single    '   'real'     1.55 
 'gear_ratio_6                '  'single    '   'real'     1.0 
 'gear_ratio_R                '  'single    '   'real'     -3.554 
 'gear_sport_1                '  'single    '   'real'     5900.0 
 'gear_sport_2                '  'single    '   'real'     5900.0 
 'gear_sport_3                '  'single    '   'real'     5850.0 
 'gear_sport_4                '  'single    '   'real'     5850.0 
 'gear_sport_5                '  'single    '   'real'     5800.0 
 'gear_upshift_1              '  'single    '   'real'     3800.0 
 'gear_upshift_2              '  'single    '   'real'     3700.0 
 'gear_upshift_3              '  'single    '   'real'     5000.0 
 'gear_upshift_4              '  'single    '   'real'     4800.0 
 'gear_upshift_5              '  'single    '   'real'     4500.0 
 'gear_upshift_thlds          '  'single    '   'real'     60.0,90.0 
 'graphics_flag               '  'single    '   'integer'  1 
 'longitudinal                '  'single    '   'integer'  1 
 'max_engine_power            '  'single    '   'real'     3.10E+08 
 'max_engine_torque           '  'single    '   'real'     1.21E+06 
 'max_gears                   '  'single    '   'integer'  3 
 'max_throttle                '  'single    '   'real'     100.0 
 'min_engine_torque           '  'single    '   'real'     -40000.0 
 'oil_dump_residual           '  'single    '   'real'     0.1 
 'oil_dump_threshold          '  'single    '   'real'     0.1 
 'oil_dump_throttle_off       '  'single    '   'real'     1.0 
 'shift_cycle_time            '  'single    '   'real'     0.5 
 'sport_flag                  '  'single    '   'integer'  1 
 'torque_tau                  '  'single    '   'real'     0.1 
 
 
 
 

12.3.3. Suspensión Delantera 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://private/templates.tbl/_Jeep_WMB_double_wishbone_leaf.tpl' 
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 MAJOR_ROLE     =  'suspension' 
 MINOR_ROLE     =  'front' 
 TIMESTAMP      =  '2020/10/16,19:51:02' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'axle_center                 '  'single    '      267.0         0.0       330.0 
 'axle_1                      '  'left/right'      267.0      -534.0       330.0 
  '(none)' 
 'bar_to_subframe             '  'left/right'      967.0      -329.0       180.0 
  '(none)' 
 'lca_front                   '  'left/right'      493.0      -229.0       180.0 
  '(none)' 
 'lca_outer                   '  'left/right'      267.0      -509.0       155.0 
  '(none)' 
 'lca_rear                    '  'left/right'      893.0      -279.0       185.0 
  '(none)' 
 'leafspring_front_axle       '  'left/right'      267.0      -329.0       160.0 
  '(none)' 
 'lwr_strut_mount             '  'left/right'      267.0      -429.0       180.0 
  '(none)' 
 'subframe_front              '  'left/right'      293.0      -279.0       180.0 
  '(none)' 
 'tierod_inner                '  'left/right'      467.0      -229.0       330.0 
  '(none)' 
 'tierod_outer                '  'left/right'      450.0      -550.0       330.0 
  '(none)' 
 'top_mount                   '  'left/right'      307.0      -329.0       680.0 
  '(none)' 
 'uca_front                   '  'left/right'      367.0      -279.0       555.0 
  '(none)' 
 'uca_outer                   '  'left/right'      307.0      -444.0       555.0 
  '(none)' 
 'uca_rear                    '  'left/right'      517.0      -319.0       560.0 
  '(none)' 
 'wheel_center                '  'left/right'      267.0      -629.0       330.0 
  '(none)' 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'subframe' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  5.0 
 SPRUNG_PERCENTAGE        =  100.0 
 SPRUNG_LOCATION          =  'front' 
 PART_LOC_X               =  267.0 
 PART_LOC_Y               =  0.0 
 PART_LOC_Z               =  30.0 
 PART_ORI_ZP1             =  0.0 
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 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  150.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'axle' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  5.0830699893 
 SPRUNG_PERCENTAGE        =  100.0 
 SPRUNG_LOCATION          =  'front' 
$ Part location is dependent. 
$   X,Y,Z location = 267.0, -267.0, 330.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0,  -1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.2128265067E+05 
 IYY                      =  1.2128265067E+05 
 IZZ                      =  987.3170318842 
 IXY                      =  0.0 
 IZX                      =  1.494680395E-11 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'axle' 
 PART        =  'axle' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  20.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'lower_strut' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  5.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 280.2, -396.0, 345.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0782061887,  0.1955154718,  0.9775773588 
$   XP vector = 0.9968152785,  0.0,  -0.0797452223 
 CM_LOCATION_FROM_PART_X  =  0.0 
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 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'spindle' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.1028403931 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 267.0, -629.0, 330.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0,  -1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  15.0 
 IXX                      =  477.8975036678 
 IYY                      =  477.8975036678 
 IZZ                      =  496.2781768857 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'tierod' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.5545428768 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 458.5, -389.5, 330.0 
$ Part orientation is dependent. 
$   ZP vector = -0.0528853894,  -0.9986005886,  0.0 
$   XP vector = 0.0,  0.0,  1.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  5785.3609861245 
 IYY                      =  5785.3609861245 
 IZZ                      =  17.7453720579 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'tierod' 
 PART        =  'tierod' 
 SYMMETRY    =  'left/right' 
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 RADIUS      =  10.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'tierod_inner' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
 PART_LOC_X               =  442.0 
 PART_LOC_Y               =  -575.0 
 PART_LOC_Z               =  330.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'tierod_inner' 
 PART        =  'tierod_inner' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  12.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'upper_strut' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  5.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 293.4, -363.0, 510.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0782061887,  0.1955154718,  0.9775773588 
$   XP vector = 0.9968152785,  0.0,  -0.0797452223 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
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 USAGE                    =  'upright' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  3.6382197927 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 267.0, -629.0, 330.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  24.7110210574 
 CM_LOCATION_FROM_PART_Y  =  50.4417588916 
 CM_LOCATION_FROM_PART_Z  =  11.696029659 
 IXX                      =  40802.739044 
 IYY                      =  42306.34705 
 IZZ                      =  8340.06541588 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'upright_lwr' 
 PART        =  'upright' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  15.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'upright_steer_arm' 
 PART        =  'upright' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  15.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'upright_upr' 
 PART        =  'upright' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  15.0 
$--------------------------------------------------------------------SWITCH_PART 
[SWITCH_PART] 
 USAGE       =  'ARB_pickup' 
 SYMMETRY    =  'left/right' 
$ Switched Parts: 
 INDEX       =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'hub_compliance' 
 SYMMETRY                =  'left/right' 
$ Bushing orientation is dependent. 
$   ZP vector = 0.0,  -1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
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 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  0.0 
 FY_SCALING_FACTOR       =  0.0 
 FZ_SCALING_FACTOR       =  0.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  0.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  0.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/MDI_hub_compliance.bus' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'lwr_strut' 
 SYMMETRY                =  'left/right' 
$ Bushing orientation is dependent. 
$   ZP vector = 0.0,  0.0,  1.0 
$   XP vector = 1.0,  0.0,  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
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 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0004.bus' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'subframe_front' 
 SYMMETRY                =  'left/right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  0.0 
 ORIENTATION_ZP3         =  1.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0004.bus' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
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[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'subframe_rear' 
 SYMMETRY                =  'left/right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  0.0 
 ORIENTATION_ZP3         =  1.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0004.bus' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'top_mount' 
 SYMMETRY                =  'left/right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  0.0 
 ORIENTATION_ZP3         =  1.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
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 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,0.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_0004.bus' 
 PROPERTY_FILE_INDEX     =  1 
$----------------------------------------------------------------DAMPER_ASSEMBLY 
[DAMPER_ASSEMBLY] 
 DEFINITION                =  '.ACAR.forces.ac_damper' 
 USAGE                     =  'ride_damper' 
 SYMMETRY                  =  'left/right' 
 PROPERTY_FILE_LIST        =  'mdids://acar_shared/dampers.tbl/mdi_shk_0001.dpr' 
 PROPERTY_FILE_INDEX       =  1 
$--------------------------------------------------------------BUMPSTOP_ASSEMBLY 
[BUMPSTOP_ASSEMBLY] 
 DEFINITION           =  '.ACAR.forces.ac_bumpstop' 
 USAGE                =  'jounce_stop' 
 SYMMETRY             =  'left/right' 
 PROPERTY_FILE_LIST   =  'mdids://acar_shared/bumpstops.tbl/mdi_0001.bum' 
 PROPERTY_FILE_INDEX  =  1 
 DISTANCE_TYPE        =  'clearance' 
 USER_DISTANCE        =  200.0 
$---------------------------------------------------------------ADJUSTABLE_FORCE 
[ADJUSTABLE_FORCE] 
 DEFINITION     =  '.ACAR.forces.ac_aforce' 
 USAGE          =  'toe_adjustment' 
 SYMMETRY       =  'left' 
 PATTERN        =  1,1,1 
 DESIRED_VALUE  =  -0.5 
 STIFFNESS      =  1.00E+06 
 DAMPING        =  20000.0 
 LOCK           =  0 
 MOTION_DELTA   =  -0.7125608826 
$---------------------------------------------------------------ADJUSTABLE_FORCE 
[ADJUSTABLE_FORCE] 
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 DEFINITION     =  '.ACAR.forces.ac_aforce' 
 USAGE          =  'toe_adjustment' 
 SYMMETRY       =  'right' 
 PATTERN        =  1,1,1 
 DESIRED_VALUE  =  -0.5 
 STIFFNESS      =  1.00E+06 
 DAMPING        =  20000.0 
 LOCK           =  0 
 MOTION_DELTA   =  -0.6271278865 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_bumpstops  '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_dampers    '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'hub_compliance_active       '  'single    '   'integer'  0 
 'hub_compliance_offset       '  'single    '   'real'     0.0 
 'subframe_active             '  'single    '   'integer'  1 
 'tbar_preload                '  'single    '   'real'     1.60E+06 
 'camber_angle                '  'left/right'   'real'     0.0 
 'drive_shaft_offset          '  'left/right'   'real'     95.0 
 'tbar_stiffness              '  'left/right'   'real'     1.50E+05 
 'toe_angle                   '  'left/right'   'real'     0.0 
 
 
 
 

12.3.4. Bellesta Delantera 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://acar_concept/templates.tbl/_example_leaf_spring.tpl' 
 MAJOR_ROLE     =  'leaf_spring' 
 MINOR_ROLE     =  'front' 
 TIMESTAMP      =  '2020/10/09,17:50:17' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'auxiliary_front_contact     '  'left/right'    -3008.4         0.0       -28.4 
 'auxiliary_rear_contact      '  'left/right'    -3008.4         0.0       -28.4 
 'leaf_front_eye              '  'left/right'     -170.0      -334.0       409.0 
  '(none)' 
 'shackle_frame               '  'left/right'      775.0      -334.0       291.0 
  '(none)' 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

142 

$------------------------------------------------------------------LEAF_ASSEMBLY 
[LEAF_ASSEMBLY] 
 USAGE          =  'example_leaf' 
 SYMMETRY       =  'left/right' 
 PROPERTY_FILE  =  'mdids://private/leafsprings.tbl/Jeep_WMB_Leafspring.ltf' 
 SPRUNG_PERCENTAGE  =  60.0 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_frame' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.1630143847,0.219171794,7.3394523792E-07 
 J_TOLERANCE             =  0.0,2.7755575616E-13,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_frame' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
 ORIENTATION_ZP3         =  0.0 
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 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.1630145376,-0.2191715015,-7.34296679E-07 
 J_TOLERANCE             =  0.0,-1.6653345369E-13,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_shackle' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 



Modelado y Simulación Dinámica del Automóvil Willys MB / Ford GPW (Jeep) 

144 

 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1630142336,0.2339766648,-2.159463719E-07 
 J_TOLERANCE             =  3.3306690739E-13,2.7755575616E-14,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_shackle' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1630146501,-0.2339763984,2.1592977404E-07 
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 J_TOLERANCE             =  0.0,-5.5511151231E-14,-5.5511151231E-14 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'shackle_to_frame' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1630147949,0.232875405,1.0621765134E-06 
 J_TOLERANCE             =  0.0,1.6653345369E-13,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'shackle_to_frame' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
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 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1630141859,-0.2328752023,-1.062159194E-06 
 J_TOLERANCE             =  0.0,0.0,1.1102230246E-13 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'check_leaf_bushings         '  'single    '   'integer'  1 
 
 
 
 
 

12.3.5. Suspensión trasera 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  '<acar_concept>/templates.tbl/_solid_axle.tpl' 
 MAJOR_ROLE     =  'suspension' 
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 MINOR_ROLE     =  'rear' 
 TIMESTAMP      =  '2020/10/09,17:18:02' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'center_of_drive_axles       '  'single    '     2321.5         0.0       330.0 
 'origin                      '  'single    '    -5084.4         0.0      -428.4 
 'hub_loc                     '  'left/right'     2321.5      -503.2       330.0 
  '(none)' 
 'hub_to_axle                 '  'left/right'     2321.5      -503.2       330.0 
  '(none)' 
 'inside_whl_cntr             '  'left/right'     2321.5      -629.0       330.0 
  '(none)' 
 'outside_whl_cntr            '  'left/right'     2321.5      -800.0       330.0 
  '(none)' 
 'shock_to_axle               '  'left/right'     2425.6     -478.04       211.6 
  '(none)' 
 'shock_to_frame              '  'left/right'     2495.6  -436.106667       501.6 
  '(none)' 
 'spring_seat                 '  'left/right'     2321.5      -415.0       356.5 
  '(none)' 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'axle_housing' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  23.9315121369 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2321.5, 0.0, 330.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.04 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  -0.01 
 IXX                      =  6.1094899002E+06 
 IYY                      =  29052.311867 
 IZZ                      =  6.1094899002E+06 
 IXY                      =  8.5617506714E-10 
 IZX                      =  -1.6564916453E-10 
 IYZ                      =  3.0739120302E-10 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'tube' 
 PART        =  'axle_housing' 
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 SYMMETRY    =  'single' 
 RADIUS      =  50.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'axle' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  2.8556572974 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2321.5, -503.2, 330.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0,  1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  81.25 
 IXX                      =  54719.848773 
 IYY                      =  54719.848773 
 IZZ                      =  2218.6899592904 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'halfshaft' 
 PART        =  'axle' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  10.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'lower_shock' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2443.1, -467.55666675, 284.1 
$ Part orientation is dependent. 
$   ZP vector = -0.2323563865,  -0.139192539,  -0.9626193156 
$   XP vector = -0.9720822086,  0.0,  0.2346405331 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'upper_shock' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
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$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2478.1, -446.59000025, 429.1 
$ Part orientation is dependent. 
$   ZP vector = -0.2323563865,  -0.139192539,  -0.9626193156 
$   XP vector = -0.9720822086,  0.0,  0.2346405331 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'lower_shock' 
 SYMMETRY                =  'left/right' 
$ Bushing orientation is dependent. 
$   ZP vector = 0.0,  1.0,  0.0 
$   XP vector = 0.2346405331,  0.0,  0.9720822086 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  180.0,90.0,101.3519412498 
 J_COMPLIANCE_ORI        =  180.0,90.0,101.3519412498 
 PROPERTY_FILE_LIST      =  '<acar_shared>/bushings.tbl/mdi_0001.bus' 
 PROPERTY_FILE_INDEX     =  1 
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$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'upper_shock' 
 SYMMETRY                =  'left/right' 
$ Bushing orientation is dependent. 
$   ZP vector = 0.0,  1.0,  0.0 
$   XP vector = -0.2346405331,  0.0,  -0.9720822086 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  180.0,90.0,281.3519412498 
 J_COMPLIANCE_ORI        =  180.0,90.0,281.3519412498 
 PROPERTY_FILE_LIST      =  '<acar_shared>/bushings.tbl/mdi_0001.bus' 
 PROPERTY_FILE_INDEX     =  1 
$----------------------------------------------------------------DAMPER_ASSEMBLY 
[DAMPER_ASSEMBLY] 
 DEFINITION                =  '.ACAR.forces.ac_damper' 
 USAGE                     =  'damper' 
 SYMMETRY                  =  'left/right' 
 PROPERTY_FILE_LIST        =  '<acar_shared>/dampers.tbl/MDI_default.dpr' 
 PROPERTY_FILE_INDEX       =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_dampers    '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
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12.3.6. Ballesta Trasera 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://acar_concept/templates.tbl/_example_leaf_spring.tpl' 
 MAJOR_ROLE     =  'leaf_spring' 
 MINOR_ROLE     =  'rear' 
 TIMESTAMP      =  '2020/10/09,17:50:05' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'auxiliary_front_contact     '  'left/right'     -954.4         0.0       -28.4 
 'auxiliary_rear_contact      '  'left/right'     -954.4         0.0       -28.4 
 'leaf_front_eye              '  'left/right'     1799.5      -395.0      290.85 
  '(none)' 
 'shackle_frame               '  'left/right'    2788.42      -395.0       373.8 
  '(none)' 
$------------------------------------------------------------------LEAF_ASSEMBLY 
[LEAF_ASSEMBLY] 
 USAGE          =  'example_leaf' 
 SYMMETRY       =  'left/right' 
 PROPERTY_FILE  =  'mdids://private/leafsprings.tbl/Jeep_WMB_Leafspring.ltf' 
 SPRUNG_PERCENTAGE  =  60.0 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_frame' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
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 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.1821707099,0.45808036,1.594527177E-06 
 J_TOLERANCE             =  0.0,5.5511151231E-14,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_frame' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.1821705255,-0.4580803344,-1.5936345021E-06 
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 J_TOLERANCE             =  0.0,-1.6653345369E-13,-1.1102230246E-13 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_shackle' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1821706179,0.3842695922,-3.6669972614E-07 
 J_TOLERANCE             =  0.0,-1.1102230246E-13,1.1102230246E-13 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'leaf_to_shackle' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
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 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.1821706829,-0.3842694091,3.6871478091E-07 
 J_TOLERANCE             =  8.881784197E-13,-5.5511151231E-14,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'shackle_to_frame' 
 SYMMETRY                =  'left' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  -1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
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 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  -0.2021706416,0.3831683835,5.307061457E-07 
 J_TOLERANCE             =  -0.02,-1.1102230246E-13,-1.1102230246E-13 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'shackle_to_frame' 
 SYMMETRY                =  'right' 
 ORIENTATION_ZP1         =  0.0 
 ORIENTATION_ZP2         =  1.0 
 ORIENTATION_ZP3         =  0.0 
 ORIENTATION_XP1         =  1.0 
 ORIENTATION_XP2         =  0.0 
 ORIENTATION_XP3         =  0.0 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
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 I_TOLERANCE             =  -0.2021706422,-0.3831684328,-5.3357979149E-07 
 J_TOLERANCE             =  -0.02,-2.4492935983E-18,-2.4492935983E-18 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 J_COMPLIANCE_ORI        =  0.0,90.0,0.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/leaf_front_bus.xml' 
 PROPERTY_FILE_INDEX     =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'check_leaf_bushings         '  'single    '   'integer'  1 
 
 
 
 

12.3.7. Dirección  
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  '<acar_concept>/templates.tbl/_parallel_link_steering.tpl' 
 MAJOR_ROLE     =  'steering' 
 MINOR_ROLE     =  'front' 
 TIMESTAMP      =  '2020/10/09,17:17:31' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'input_shaft_forward         '  'single    '      600.0      -169.0       430.0 
  '(none)' 
 'intermediate_shaft_forward  '  'single    '      700.0      -169.0       530.0 
  '(none)' 
 'intermediate_shaft_rearward '  'single    '      850.0      -269.0       930.0 
  '(none)' 
 'steering_wheel_center       '  'single    '     1350.0      -269.0      1047.0 
  '(none)' 
 'arm_forward                 '  'left/right'      525.0      -194.0       330.0 
  '(none)' 
 'arm_rearward                '  'left/right'      625.0      -194.0       330.0 
  '(none)' 
 'arm_upper                   '  'left/right'      625.0      -194.0       430.0 
  '(none)' 
 'tierod_inner                '  'left/right'      467.0      -229.0       330.0 
  '(none)' 
$------------------------------------------------------------------PART_ASSEMBLY 
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[PART_ASSEMBLY] 
 USAGE                    =  'ball_screw' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.2773500981 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 582.3223304703, -169.0, 412.3223304703 
$ Part orientation is dependent. 
$   ZP vector = 0.7071067812,  0.0,  0.7071067812 
$   XP vector = 0.7071067812,  0.0,  -0.7071067812 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  73.4750121788 
 IYY                      =  73.4750121788 
 IZZ                      =  31.387483477 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'ball_screw' 
 PART        =  'ball_screw' 
 SYMMETRY    =  'single' 
 RADIUS      =  15.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'center_link' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  3.424590723 
 SPRUNG_PERCENTAGE        =  100.0 
 PART_LOC_X               =  250.0 
 PART_LOC_Y               =  0.0 
 PART_LOC_Z               =  30.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  265.8180179114 
 CM_LOCATION_FROM_PART_Y  =  -1.5880520905 
 CM_LOCATION_FROM_PART_Z  =  300.0 
 IXX                      =  2.0295542263E+05 
 IYY                      =  1541.6943209038 
 IZZ                      =  2.0422202042E+05 
 IXY                      =  -49.9355526823 
 IZX                      =  -5.5511151231E-11 
 IYZ                      =  1.4094628242E-11 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'center_link_middle' 
 PART        =  'center_link' 
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 SYMMETRY    =  'single' 
 RADIUS      =  12.7 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'center_link_outer' 
 PART        =  'center_link' 
 SYMMETRY    =  'single' 
 RADIUS      =  12.7 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'center_link_right' 
 PART        =  'center_link' 
 SYMMETRY    =  'single' 
 RADIUS      =  12.7 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'input_shaft' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.7844645406 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 650.0, -169.0, 480.0 
$ Part orientation is dependent. 
$   ZP vector = 0.7071067812,  0.0,  0.7071067812 
$   XP vector = 0.7071067812,  0.0,  -0.7071067812 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1351.8295057462 
 IYY                      =  1351.8295057462 
 IZZ                      =  88.7772096439 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'input_shaft' 
 PART        =  'input_shaft' 
 SYMMETRY    =  'single' 
 RADIUS      =  15.0445459276 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'intermediate_shaft' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 775.0, -219.0, 730.0 
$ Part orientation is dependent. 
$   ZP vector = 0.3418817294,  -0.2279211529,  0.9116846117 
$   XP vector = 0.9363291776,  0.0,  -0.3511234416 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
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 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  2764.9179238818 
 IYY                      =  2764.9179238818 
 IZZ                      =  113.1691810841 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'intermediate_shaft' 
 PART        =  'intermediate_shaft' 
 SYMMETRY    =  'single' 
 RADIUS      =  15.0445459276 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'rack' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.3970225415 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 582.3223304703, -169.0, 412.3223304703 
$ Part orientation is dependent. 
$   ZP vector = 0.7071067812,  0.0,  0.7071067812 
$   XP vector = 0.7071067812,  0.0,  -0.7071067812 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  114.8718553432 
 IYY                      =  114.8718553432 
 IZZ                      =  64.3176517244 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'rack' 
 PART        =  'rack' 
 SYMMETRY    =  'single' 
 RADIUS      =  18.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'steering_column' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.7374889711 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1100.0, -269.0, 988.5 
$ Part orientation is dependent. 
$   ZP vector = -0.9736973717,  0.0,  -0.227845185 
$   XP vector = -0.227845185,  0.0,  0.9736973717 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
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 IXX                      =  14576.457943 
 IYY                      =  14576.457943 
 IZZ                      =  194.766368528 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'steering_column' 
 PART        =  'steering_column' 
 SYMMETRY    =  'single' 
 RADIUS      =  14.9730733795 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'steering_gear_housing' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 625.0, -194.0, 430.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'steering_wheel' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  2.1500262923 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1350.0, -269.0, 1047.0 
$ Part orientation is dependent. 
$   ZP vector = -0.9736973717,  0.0,  -0.227845185 
$   XP vector = -0.227845185,  0.0,  0.9736973717 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.5768768867 
 IXX                      =  25892.147854 
 IYY                      =  25892.147854 
 IZZ                      =  51629.176982 
 IXY                      =  0.0 
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 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'arm' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.6542605896 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 591.6666666667, -194.0, 363.3333333333 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  16.6666666667 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  16.6666666667 
 IXX                      =  3462.459317439 
 IYY                      =  4809.9924227329 
 IZZ                      =  1719.7417379582 
 IXY                      =  0.0 
 IZX                      =  1378.5504913493 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'arm' 
 PART        =  'arm' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  12.7 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'pivot_shaft' 
 PART        =  'arm' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  12.7 
$--------------------------------------------------------------------SWITCH_PART 
[SWITCH_PART] 
 USAGE       =  'steering_gear_mount' 
 SYMMETRY    =  'left/right' 
$ Switched Parts: 
$   [1] = chassis (general part) 
$   [2] = nd (unknown part) 
 INDEX       =  1 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'steering_torsion_bar' 
 SYMMETRY                =  'single' 
$ Bushing orientation is dependent. 
$   ZP vector = 0.7071067812,  0.0,  0.7071067812 
$   XP vector = 0.7071067812,  0.0,  -0.7071067812 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
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 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  90.0,45.0,270.0 
 J_COMPLIANCE_ORI        =  90.0,45.0,270.0 
 PROPERTY_FILE_LIST      =  'mdids://acar_shared/bushings.tbl/mdi_steering_tbar.bus' 
 PROPERTY_FILE_INDEX     =  1 
$------------------------------------------------------------------GEAR_ASSEMBLY 
[GEAR_ASSEMBLY] 
 USAGE            =  'ball_screw_input_shaft_lock' 
 SYMMETRY         =  'single' 
 REDUCTION_RATIO  =  1.0 
 INVERT_INPUT     =  'no' 
$------------------------------------------------------------------GEAR_ASSEMBLY 
[GEAR_ASSEMBLY] 
 USAGE            =  'ball_screw_rack' 
 SYMMETRY         =  'single' 
 REDUCTION_RATIO  =  0.4947390006 
 INVERT_INPUT     =  'no' 
$------------------------------------------------------------------GEAR_ASSEMBLY 
[GEAR_ASSEMBLY] 
 USAGE            =  'pitman_arm_rack' 
 SYMMETRY         =  'single' 
 REDUCTION_RATIO  =  0.0309211875 
 INVERT_INPUT     =  'yes' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'steering_assist' 
 SYMMETRY       =  'single' 
 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  '<acar_concept>/steering_assists.tbl/pickup_steer_assist.ste' 
 CURVE_NAME     =  'steering_assist' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
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 USAGE          =  'torsion_bar' 
 SYMMETRY       =  'single' 
 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  '<acar_concept>/steering_assists.tbl/pickup_steer_assist.ste' 
 CURVE_NAME     =  'torsion_bar' 
$--------------------------------------------------------------GENERAL_PARAMETER 
[GENERAL_PARAMETER] 
 USAGE           =  'rack_piston_area' 
 SYMMETRY        =  'single' 
 PROPERTY_FILE   =  '<acar_concept>/steering_assists.tbl/pickup_steer_assist.ste' 
 DATA_BLOCK      =  'steering_assist' 
 ATTRIBUTE_NAME  =  'piston_area' 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'steering_assist_active      '  'single    '   'integer'  1 
 'max_rack_displacement       '  'single    '   'real'     50.0 
 'max_rack_force              '  'single    '   'real'     750.0 
 'max_steering_angle          '  'single    '   'real'     720.0 
 'max_steering_torque         '  'single    '   'real'     750.0 
 
 
 
 

12.3.8. Drivelne 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  '<acar_concept>/templates.tbl/_driveline_4wd.tpl' 
 MAJOR_ROLE     =  'driveline' 
 MINOR_ROLE     =  'any' 
 TIMESTAMP      =  '2020/10/09,17:19:28' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------HARDPOINT 
[HARDPOINT] 
{hardpoint_name                  symmetry         x_value    y_value    z_value} 
 'front_diff_mount            '  'single    '        0.0         0.0       250.0 
 'propshaft_intermediate      '  'single    '     1700.0         0.0       400.0 
 'rear_diff_input             '  'single    '     2115.6         0.0       321.6 
  '(none)' 
 'rear_diff_mount             '  'single    '     2321.5         0.0       330.0 
  '(none)' 
 'front_inner_CVJ             '  'left/right'      270.0      -350.0       380.0 
 'rear_diff_output            '  'left/right'     2321.5      -150.0       330.0 
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  '(none)' 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'front_diff_housing' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 0.0, 0.0, 250.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'front_diff_input' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.6955492391 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 883.0, 0.0, 549.0 
$ Part orientation is dependent. 
$   ZP vector = 1.0,  0.0,  0.0 
$   XP vector = 0.0,  -1.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  7.5 
 IXX                      =  347.6321760416 
 IYY                      =  347.6321760416 
 IZZ                      =  669.1812556173 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'propshaft_front' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  16.3842039712 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
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$   X,Y,Z location = 1291.5, 0.0, 474.5 
$ Part orientation is dependent. 
$   ZP vector = -0.9837734371,  0.0,  0.179415229 
$   XP vector = 0.179415229,  0.0,  0.9837734371 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  -81.9092164988 
 IXX                      =  1.4070958917E+06 
 IYY                      =  1.4070958917E+06 
 IZZ                      =  6480.7191156588 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'propshaft' 
 PART        =  'propshaft_front' 
 SYMMETRY    =  'single' 
 RADIUS      =  25.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'propshaft_input' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 883.0, 0.0, 549.0 
$ Part orientation is dependent. 
$   ZP vector = 1.0,  0.0,  0.0 
$   XP vector = 0.0,  0.0,  -1.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  -12.5 
 IXX                      =  618.0285844632 
 IYY                      =  618.0285844632 
 IZZ                      =  1115.3020926956 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'propshaft_rear' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  20.4778423837 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1907.8, 0.0, 360.8 
$ Part orientation is dependent. 
$   ZP vector = -0.9826681556,  0.0,  0.1853733961 
$   XP vector = 0.1853733961,  0.0,  0.9826681556 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
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 IXX                      =  3.2380131504E+06 
 IYY                      =  3.2380131504E+06 
 IZZ                      =  6214.9088186912 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'propshaft' 
 PART        =  'propshaft_rear' 
 SYMMETRY    =  'single' 
 RADIUS      =  25.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'rear_diff_housing' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2321.5, 0.0, 330.0 
 PART_ORI_ZP1             =  0.0 
 PART_ORI_ZP2             =  0.0 
 PART_ORI_ZP3             =  1.0 
 PART_ORI_XP1             =  1.0 
 PART_ORI_XP2             =  0.0 
 PART_ORI_XP3             =  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'rear_diff_input' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2115.6, 0.0, 321.6 
$ Part orientation is dependent. 
$   ZP vector = 0.9826681556,  0.0,  -0.1853733961 
$   XP vector = -0.1853733961,  0.0,  -0.9826681556 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
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 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'slip_yoke' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  6.1268910727 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1700.0, 0.0, 400.0 
$ Part orientation is dependent. 
$   ZP vector = 0.9826681556,  0.0,  -0.1853733961 
$   XP vector = -0.1853733961,  0.0,  -0.9826681556 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  50.0 
 IXX                      =  8935.0494809676 
 IYY                      =  8935.0494809676 
 IZZ                      =  7658.6138408294 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'support_bearing' 
 SYMMETRY                 =  'single' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 1610.13, 0.0, 416.39 
$ Part orientation is dependent. 
$   ZP vector = -0.9837734371,  0.0,  0.179415229 
$   XP vector = -0.179415229,  0.0,  -0.9837734371 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1000.0 
 IYY                      =  1000.0 
 IZZ                      =  1800.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'front_diff_output' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.6955492391 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 270.0, -300.0, 380.0 
$ Part orientation is dependent. 
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$   ZP vector = 0.0,  -1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  -7.5 
 IXX                      =  347.6321760416 
 IYY                      =  347.6321760416 
 IZZ                      =  669.1812556173 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'jack_shaft' 
 PART        =  'front_diff_output' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  10.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'front_halfshaft' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  0.4759428829 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 268.5, -442.0, 355.0 
$ Part orientation is dependent. 
$   ZP vector = -0.0157318378,  -0.9648860489,  -0.2621972959 
$   XP vector = -0.9982048455,  0.0,  0.0598922907 
 CM_LOCATION_FROM_PART_X  =  -7.1945222485E-17 
 CM_LOCATION_FROM_PART_Y  =  -9.4719453016E-16 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1598.0319531885 
 IYY                      =  1598.0319531885 
 IZZ                      =  23.1113537426 
 IXY                      =  -7.3173293909E-14 
 IZX                      =  1.3583011124E-13 
 IYZ                      =  7.0640434308E-14 
$------------------------------------------------------------------LINK_GEOMETRY 
[LINK_GEOMETRY] 
 USAGE       =  'front_halfshaft' 
 PART        =  'front_halfshaft' 
 SYMMETRY    =  'left/right' 
 RADIUS      =  10.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'front_tripod' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 270.0, -350.0, 380.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0,  -1.0,  0.0 
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$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$------------------------------------------------------------------PART_ASSEMBLY 
[PART_ASSEMBLY] 
 USAGE                    =  'rear_diff_output' 
 SYMMETRY                 =  'left/right' 
 MODE                     =  'rigid' 
$ Rigid body data: 
 MASS                     =  1.0 
 SPRUNG_PERCENTAGE        =  100.0 
$ Part location is dependent. 
$   X,Y,Z location = 2321.5, -150.0, 330.0 
$ Part orientation is dependent. 
$   ZP vector = 0.0,  -1.0,  0.0 
$   XP vector = 1.0,  0.0,  0.0 
 CM_LOCATION_FROM_PART_X  =  0.0 
 CM_LOCATION_FROM_PART_Y  =  0.0 
 CM_LOCATION_FROM_PART_Z  =  0.0 
 IXX                      =  1.0 
 IYY                      =  1.0 
 IZZ                      =  1.0 
 IXY                      =  0.0 
 IZX                      =  0.0 
 IYZ                      =  0.0 
$--------------------------------------------------------------------SWITCH_PART 
[SWITCH_PART] 
 USAGE       =  'front_diff_mount' 
 SYMMETRY    =  'single' 
$ Switched Parts: 
$   [1] = chassis (general part) 
$   [2] = powertrain (general part) 
$   [3] = subframe (general part) 
 INDEX       =  1 
$--------------------------------------------------------------------SWITCH_PART 
[SWITCH_PART] 
 USAGE       =  'rear_diff_mount' 
 SYMMETRY    =  'single' 
$ Switched Parts: 
$   [1] = chassis (general part) 
$   [2] = powertrain (general part) 
$   [3] = nd (unknown part) 
$   [4] = axle_housing (general part) 
 INDEX       =  4 
$---------------------------------------------------------------BUSHING_ASSEMBLY 
[BUSHING_ASSEMBLY] 
 DEFINITION              =  '.ACAR.attachments.ac_bushing' 
 USAGE                   =  'support_bearing_to_body' 
 SYMMETRY                =  'single' 
$ Bushing orientation is dependent. 
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$   ZP vector = -0.9837734371,  0.0,  0.179415229 
$   XP vector = -0.179415229,  0.0,  -0.9837734371 
 T_PRELOAD_X             =  0.0 
 T_PRELOAD_Y             =  0.0 
 T_PRELOAD_Z             =  0.0 
 R_PRELOAD_X             =  0.0 
 R_PRELOAD_Y             =  0.0 
 R_PRELOAD_Z             =  0.0 
 T_OFFSET_X              =  0.0 
 T_OFFSET_Y              =  0.0 
 T_OFFSET_Z              =  0.0 
 R_OFFSET_X              =  0.0 
 R_OFFSET_Y              =  0.0 
 R_OFFSET_Z              =  0.0 
 FX_SCALING_FACTOR       =  1.0 
 FY_SCALING_FACTOR       =  1.0 
 FZ_SCALING_FACTOR       =  1.0 
 TX_SCALING_FACTOR       =  1.0 
 TY_SCALING_FACTOR       =  1.0 
 TZ_SCALING_FACTOR       =  1.0 
 TX_DAMPING_FORCE_SCALE  =  1.0 
 TY_DAMPING_FORCE_SCALE  =  1.0 
 TZ_DAMPING_FORCE_SCALE  =  1.0 
 RX_DAMPING_FORCE_SCALE  =  1.0 
 RY_DAMPING_FORCE_SCALE  =  1.0 
 RZ_DAMPING_FORCE_SCALE  =  1.0 
 I_TOLERANCE             =  0.0,0.0,0.0 
 J_TOLERANCE             =  0.0,0.0,0.0 
 I_ORI_TYPE              =  'default' 
 J_ORI_TYPE              =  'default' 
 I_COMPLIANCE_ORI        =  270.0,85.91438322,90.0 
 J_COMPLIANCE_ORI        =  270.0,85.91438322,90.0 
 PROPERTY_FILE_LIST      =  '<acar_shared>/bushings.tbl/mdi_0001.bus' 
 PROPERTY_FILE_INDEX     =  1 
$------------------------------------------------------------------GEAR_ASSEMBLY 
[GEAR_ASSEMBLY] 
 USAGE            =  'front_diff' 
 SYMMETRY         =  'single' 
 REDUCTION_RATIO  =  3.0 
 INVERT_INPUT     =  'no' 
$------------------------------------------------------------------GEAR_ASSEMBLY 
[GEAR_ASSEMBLY] 
 USAGE            =  'rear_diff' 
 SYMMETRY         =  'single' 
 REDUCTION_RATIO  =  3.0 
 INVERT_INPUT     =  'no' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'front_differential' 
 SYMMETRY       =  'single' 
 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  '<acar_concept>/differentials.tbl/open_no_torque.dif' 
 CURVE_NAME     =  'DIFFERENTIAL' 
$-----------------------------------------------------------------GENERAL_SPLINE 
[GENERAL_SPLINE] 
 USAGE          =  'rear_differential' 
 SYMMETRY       =  'single' 
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 TYPE           =  'two_dimensional' 
 PROPERTY_FILE  =  '<acar_concept>/differentials.tbl/MDI_viscous.dif' 
 CURVE_NAME     =  'DIFFERENTIAL' 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'driveline_active            '  'single    '   'string'   'front,rear' 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_actuators  '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_bushings   '  'single    '   'integer'  1,1,0,1,0,0,0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'propshaft_front_length      '  'single    '   'real'     500.0 
 'jack_shaft_active           '  'left/right'   'integer'  0 
 'jack_shaft_length           '  'left/right'   'real'     50.0 
 
 
 
 

12.3.9. Ruedas Delanteras 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://private/templates.tbl/_Jeep_WMB_handling_tire.tpl' 
 MAJOR_ROLE     =  'wheel' 
 MINOR_ROLE     =  'front' 
 TIMESTAMP      =  '2020/10/09,17:19:03' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$-----------------------------------------------------------------WHEEL_ASSEMBLY 
[WHEEL_ASSEMBLY] 
 USAGE                =  'wheel' 
 SYMMETRY             =  'left/right' 
 MASS                 =  12.0 
 SPRUNG_PERCENTAGE    =  0.0 
 IXX                  =  50000.0 
 IYY                  =  50000.0 
 IZZ                  =  10000.0 
 CM_OFFSET            =  0.0 
 WHEEL_CENTER_OFFSET  =  0.0 
 HIGH_PERFORMANCE     =  'no' 
 DEFINITION           =  '.ACAR.forces.ac_tire' 
 CONTACT_TYPE         =  'handling' 
 PROPERTY_FILE_LIST   =  'mdids://acar_shared/tires.tbl/mdi_tire01.tir' 
 PROPERTY_FILE_INDEX  =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
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 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'graphics_angle_offset       '  'left/right'   'real'     0.0 
 
 
 
 

12.3.10. Ruedas Traseras 
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  'mdids://private/templates.tbl/_Jeep_WMB_handling_tire.tpl' 
 MAJOR_ROLE     =  'wheel' 
 MINOR_ROLE     =  'rear' 
 TIMESTAMP      =  '2020/10/09,17:18:55' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$-----------------------------------------------------------------WHEEL_ASSEMBLY 
[WHEEL_ASSEMBLY] 
 USAGE                =  'wheel' 
 SYMMETRY             =  'left/right' 
 MASS                 =  12.0 
 SPRUNG_PERCENTAGE    =  0.0 
 IXX                  =  50000.0 
 IYY                  =  50000.0 
 IZZ                  =  10000.0 
 CM_OFFSET            =  0.0 
 WHEEL_CENTER_OFFSET  =  0.0 
 HIGH_PERFORMANCE     =  'no' 
 DEFINITION           =  '.ACAR.forces.ac_tire' 
 CONTACT_TYPE         =  'handling' 
 PROPERTY_FILE_LIST   =  'mdids://acar_shared/tires.tbl/mdi_tire01.tir' 
 PROPERTY_FILE_INDEX  =  1 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                  symmetry       type       value} 
 'kinematic_flag              '  'single    '   'integer'  0 
 'request_activity_joints     '  'single    '   'integer'  0,0,0,0,0,0,0 
 'graphics_angle_offset       '  'left/right'   'real'     0.0 
 
 
 
 

12.3.11. Frenos  
$---------------------------------------------------------------------MDI_HEADER 
[MDI_HEADER] 
 FILE_TYPE     =  'sub' 
 FILE_VERSION  =  8.0 
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 FILE_FORMAT   =  'ASCII' 
$---------------------------------------------------------------SUBSYSTEM_HEADER 
[SUBSYSTEM_HEADER] 
 TEMPLATE_NAME  =  '<acar_shared>/templates.tbl/_brake_system_4Wdisk.tpl' 
 MAJOR_ROLE     =  'brake_system' 
 MINOR_ROLE     =  'any' 
 TIMESTAMP      =  '2020/10/09,17:16:31' 
$--------------------------------------------------------------------------UNITS 
[UNITS] 
 LENGTH  =  'mm' 
 FORCE   =  'newton' 
 ANGLE   =  'deg' 
 MASS    =  'kg' 
 TIME    =  'sec' 
$----------------------------------------------------------------------PARAMETER 
[PARAMETER] 
{parameter_name                   symmetry       type       value} 
 'kinematic_flag               '  'single    '   'integer'  0 
 'brake_reduction              '  'single    '   'real'     0.0 
 'front_brake_bias             '  'single    '   'real'     0.6 
 'front_brake_left_side_bias   '  'single    '   'real'     1.0 
 'front_brake_mu               '  'single    '   'real'     0.3 
 'front_effective_piston_radius'  'single    '   'real'     110.0 
 'front_piston_area            '  'single    '   'real'     1000.0 
 'front_rotor_hub_wheel_offset '  'single    '   'real'     0.0 
 'front_rotor_hub_width        '  'single    '   'real'     50.0 
 'front_rotor_width            '  'single    '   'real'     -25.0 
 'max_brake_value              '  'single    '   'real'     100.0 
 'rear_brake_mu                '  'single    '   'real'     0.3 
 'rear_effective_piston_radius '  'single    '   'real'     110.0 
 'rear_piston_area             '  'single    '   'real'     1000.0 
 'rear_rotor_hub_wheel_offset  '  'single    '   'real'     65.0 
 'rear_rotor_hub_width         '  'single    '   'real'     40.0 
 'rear_rotor_width             '  'single    '   'real'     -25.0 
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